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Limited Use Software License Agreement 
Microcomputers or Computer Networks 

1. About this Agreement. This is the WordStar International Incorporated (“WordStar”) Limited Use Software License Agreement (the 

“ Agreement”) which governs your use of the WordStar products enclosed with it including the manuals, media, computer program, and related 

materials (the “Software”). This Agreement applies to the Software for a single microcomputer or the Software for a computer network (defined as a 

file server connected to any combination of two or more work stations that are electronically linked and capable of sharing the use of a single software 

program). The enclosed Software will not work on both a microcomputer and a computer network. 

2. YOU AGREE TO THE TERMS OF THIS AGREEMENT BY THE ACT OF OPENING THE SEALED PACKAGE WHICH CONTAINS THE MEDIA. 

DO NOT OPEN THE SEALED PACKAGE WITHOUT FIRST READING, UNDERSTANDING, AND AGREEING TO THE TERMS AND 

CONDITIONS OF THIS AGREEMENT. IF YOU DO NOT AGREE TO THE TERMS OF THIS AGREEMENT, PROMPTLY RETURN THE SOFTWARE 

TO YOUR DEALER FOR A FULL REFUND. 

3. Grant of License. This license governs the use of the Software for either a single microcomputer or for a file server with appropriately licensed 

work stations on a computer network. MICROCOMPUTER: If the enclosed Software is for use on a microcomputer, WordStar hereby grants you a 

limited license to use the Software on a single terminal connected to a single microcomputer or on its temporary or permanent replacement. You may 

not transfer or sublicense, either temporarily or permanently, your right to use the Software under this Agreement except as provided for in part 10 of 

this Agreement. If you wish to use the Software on more than one (1) microcomputer, you must license additional copies from your dealer or from 

WordStar. COMPUTER NETWORK: If the enclosed Software is for use on a computer network, WordStar hereby grants you a limited license to use 

the Software on a computer network file server and with the workstation as described in this WordStar product. You may not transfer or sublicense, 

either temporarily or permanently, your right to use the Software under this Agreement except as provided for in part 10 of this Agreement. If you 

wish to use the Software on additional workstations, you must license additional workstations from your dealer or from WordStar. 

4. Term. This Agreement is effective from the day you open the sealed package containing the media and continues until you return the original 

media to WordStar, in which case you must also certify in writing that you have destroyed any archival copies you may have recorded on any 

memory system or magnetic medium. 

5. WordStar's Rights. You acknowledge that the Software is the sole and exclusive property of WordStar. By accepting this Agreement, you do not 

become the owner of the Software, but you do have the right to use the Software in accordance with this Agreement. You agree not to disassemble, 

decompile, or otherwise reverse engineer the Software. 

6. Your Original Media/Archival Copies. The media enclosed contain an original WordStar label. Use the original media to make up to three (3) 

“back-up” or archival copies for the purpose of running the Software program. If the enclosed Software is for use on a microcomputer, you should not 

use the original media in your microcomputer except to create the archival copies. After recording the archival copies, place the original media in a 

safe place. Other than these archival copies, you agree that no other copies of the Software will be made. 

7. Customer Registration. WordStar may from time to time revise or update the Software. Revisions can be provided to you only if you have 

returned the User Registration Card to WordStar and if your diskettes are the originals. WordStar’s customer services are available only to registered 

WordStar users. 3 

8. Limited Warranty. WordStar warrants for a period of ninety (90) days from the date of purchase that, under normal use, the material of the media 

and the user manuals will not prove defective; that the Software program will prove to operate substantially in accordance with what is described in 

the enclosed documentation; that the Software program is properly recorded on the media; and that the user manuals are substantially complete and 

contain all information which WordStar deems necessary for the use of the Software. 

WordStar or your dealer will replace flawed diskettes that are returned within ninety (90) days of the date of purchase. If you report, in writing, a 

significant defect in the Software program, and WordStar is unable to correct the defect within ninety (90) days, you may return the Software to 

WordStar for a full refund of the purchase price. | 

9. Liability. You agree that WordStar’s entire liability, at WordStar’s option, shall be limited to replacement of the Software or . refund of the 

purchase price. 

WORDSTAR WILL NOT BE RESPONSIBLE FOR ANY DIRECT, INCIDENTAL, OR CONSEQUENTIAL DAMAGES INCLUDING, FOR EXAMPLE, 

LOSS OF PROFITS RESULTING FROM THE USE OR THE INABILITY TO USE THE SOFTWARE OR ARISING OUT OF ANY BREACH OF THE 

WARRANTY, EVEN IF WORDSTAR HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. 

SOME STATES DO NOT ALLOW THE LIMITATION OR EXCLUSION OF LIABILITY FOR INCIDENTAL OR CONSEQUENTIAL DAMAGES, SO _ 

THE ABOVE LIMITATION OR EXCLUSION MAY NOT APPLY TO YOU. YOU MAY ALSO HAVE OTHER RIGHTS WHICH VARY FROM STATE 

TO STATE. 

10. Sublicensing and Transferability. You may transfer or sublicense your right to use this Software. Should you sublicense or transfer your right to 

use the Software under this Agreement, the new user, owner, or transferee (the “Transferee”) will not be covered under the Limited Warranty as 

expressed in part 8. WordStar will not be liable for any damages in any amount to a Transferee. The Transferee must agree to all other terms and 

conditions of this Agreement before taking possession of the Software. 

11. Governing Law. This Agreement is to be governed by, and interpreted in accordance with the laws of the State of California and the United 

States. Any terms or conditions of this Agreement found to be unenforceable, illegal, or contrary to public policy in any jurisdiction will be deleted, but 

will not affect the remaining terms and conditions of this Agreement. 

12. Entire Agreement. This Agreement constitutes the entire agreement between you and WordStar. 

13. For Government Users. RESTRICTED RIGHTS LEGEND: Use, duplication, or disclosure by the Government is subject to restrictions as set forth 

in subparagraph (c)(1)(ii) of the Rights in Technical Data and Computer Software clause at DFARS 252.227-7013. WordStar International Incorporated, 

201 Alameda del Prado, P.O. Box 6113, Novato, CA 94949. 
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Notices 

Copyright © 1993 Writing Tools Group, Inc. All rights reserved. Writing Tools Group, Inc. 
is a subsidiary of WordStar International Incorporated. No part of this publication may be 
reproduced, displayed on a computer system, transmitted, transcribed, stored in a retrieval 
system, or translated into any language or computer language, in any form or by any means, 
electronic, mechanical, magnetic, optical, chemical, manual, or otherwise, without the prior 

written consent of Writing Tools Group, Inc. 

Inquiries may be forwarded to: 
WordStar International Incorporated WordStar International Limited 
201 Alameda del Prado Chancery House 
P.O. Box 6113 St. Nicholas Way 
Novato, CA 94948 i Sutton, Surrey 

USA: SM1 1JB, England 

Correct Grammar is a registered trademark of Writing Tools Group, Inc. CorrecText is a 
registered trademark of Houghton Mifflin Company. WordStar is a registered trademark of 
WordStar International Incorporated. All other product names in this publication are — 
trademarks or registered trademarks of their respective owners. 

CorrecText Grammar Correction System licensed from Houghton Mifflin Company. 
Copyright © 1990 by Houghton Mifflin Company. All rights reserved. Underlying 
technology developed by Language Systems, Inc. U.S. Pat. Nos. 4,868,750; 4,864,502; 
4,864,501; 4,773, 009; 4,771,401; 4,730,269; and 4,580,241. Canadian Pat. No. 1,203,916. 
Reproduction or disassembly of embodied programs or databases prohibited. 

No investigation has been made of common-law trademark rights in any word. Words that 
are known to have current registrations are shown with an initial capital. The inclusion or 
exclusion of any word, or its capitalizations, in the CorrecText Grammar Correction System 
database is not, however, an expression of the developer’s opinion as to whether or not it is 
subject to proprietary rights, nor is it to be regarded as affecting the validity of any 
trademark. * 

RESTRICTED RIGHTS LEGEND: The use, duplication, or disclosure by the Government is © 
subject to restrictions as set forth in subparagraph (c)(1)Gi) of the Rights in Technical Data 
and Computer Software Clause at DFARS 252.227-7013. Writing Tools Group, Inc., 201 
Alameda del Prado, P.O. Box 6113, Novato, CA 94948. | 
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Preface 

Overview 

Correct Grammar is based on the powerful CorrecText® Grammar 
Correction System developed by the Houghton Mifflin Company and 
the world’s leading authorities on computational linguistics. 

Correct Grammar can function as an online editor and help you pro- 
duce clearly written, readable documents by checking your documents 

for spelling, word usage, grammar, and readability. 

You will find using Correct Grammar as easy as using your spelling 

checker—just let it search for possible problems, and you can respond 

to the easy prompts and menu choices. 

What Correct Grammar Does 

Correct Grammar identifies errors in grammar, word usage, punctua- 

tion, style, and spelling. 

In addition, Correct Grammar can apply standard readability tests to 
your documents to locate readability problems, such as overly long 
sentences or passive voice. And when Correct Grammar finishes 
checking your document, it can display a summary of its readability. 

As Correct Grammar checks your document, it suggests corrections 
that you can make. You can also request more information about the 
suggestions and related problems. 

vil 
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Correct Grammar can display explanations that tell you what may be 
wrong with the text that it has highlighted, how to correct the text, and 
how to avoid the mistake in your future writing. 

Why Correct Grammar Is Easy to Use 

= Correct Grammar is easy to install. 

You just run the installation program, and Correct Grammar is 
automatically installed onto your desktop. 

= You can check all or part of a document. 

You can check as much of a document as you want; you don’t have 
to waste time doing unnecessary checking. 

= Correct Grammar provides online help. 

Just use the Help command. If you are using System 7.0 or later, 
Help appears in balloons. 

=” Many of the grammatical suggestions are linked to an online 
tutorial. | 

When Correct Grammar finds a grammatical error in your 
document, it describes the error and suggests how to correct it. 

Many explanations are linked to the online tutorial, so you can use 
the Tutorial command to display a lesson on the writing principle 
that applies to the suggestion. The tutorial may include examples 
of correct sentences or word usage. When you finish with the 
tutorial, Correct Grammar returns you to the same place in your 
document. 

= You can use existing grammar rules or create your own rules. 

Correct Grammar is based on the expertise of the publishers of the 
American Heritage Dictionary. It has thousands of grammar rules 
and its own 135,000-word spelling dictionary. 

vill 
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You can either use these rules or write your own rules. The Correct 
Grammar MakeRules application allows you to create rules that 
Correct Grammar uses to find and correct errors. The rules you 
create may, for example, conform to a corporate standard or your 
personal writing style. 

Correct Grammar can check grammar in many types of word 
processing documents. And it works with any application that can 
copy text to the Clipboard. 

About This Manual 

This manual consists of the following chapters and appendices: 

Chapter 1, “Getting Started,” describes how to install Correct 

Grammar on your Macintosh, how to start Correct Grammar for 
the first time, how to learn to use Correct Grammar, and what to 

do if you need help or have problems installing or using Correct 
Grammar. 

Chapter 2, “Using Correct Grammar,” describes how to use Correct 
Grammar to check a document. 

Chapter 3, “Using Options,” describes the options that you can use 
to modify the way Correct Grammar checks your documents. 

Chapter 4, “Customizing Correct Grammar,” describes how to 
choose, review, and customize predefined style guides. 

Appendix A, “Examples of Common Grammar Problems,” 
describes common grammar problems and how Correct Grammar 
suggests correcting them. 

Appendix B, “The Philosophy and Methodology of Correct 
Grammar,” provides background information on how Correct 
Grammar checks documents and why it works the way it does. 
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= Appendix C, “Writing Your Own Rules,” gives detailed 
instructions for writing your own grammar rules and compiling 
them with the MakeRules application. 



Chapter 1 

Getting Started 

In this chapter you'll learn 

CL 

I 

What you need to get started with Correct Grammar 

How to install the application on your computer 

How to start Correct Grammar for the first time 

How to use the tutorial files to learn about Correct Grammar 

Before You Begin 
To set up and use Correct Grammar on your Macintosh, you need an 
understanding of basic Macintosh concepts. Before you begin instal- 
ling Correct Grammar, you should know how to 

a 

LI 

Use icons on the desktop 

Use the mouse to point, click, and double-click 

Start and quit applications 

Open, copy, and delete documents 
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= Pull down menus and choose commands 

2 Scroll in windows 

a Use the Clipboard to store information 

If you are not familiar with these tasks, see the manual that came with 
your system software disks. 

What You Need to Get Started 

To use Correct Grammar, you must have a Macintosh computer with a 
hard disk. 

Also, your Macintosh System and Finder files must be compatible 
with Correct Grammar. You must be using System 6.0 or later, with a 
comparable Finder version. (Correct Grammar is compatible with 
System 7.0 and later.) To check the System and Finder versions on 
your computer, choose About the Finder from the Apple (86 ) menu. 

If your system software is not compatible with Correct Grammar, you 
can get the latest versions from your authorized Apple dealer in a sys- 
tem software update. 

Note: It’s a good idea to install your word processing programs before 
you install Correct Grammar, although you can also install word pro- 
cessing programs later. . 

Enhancing Performance 

You may enhance the performance of Correct Grammar (and many 
other applications) by turning on RAM Cache. RAM Cache causes 
information that is frequently obtained from the hard disk to be saved 
in RAM. To find out how to turn on RAM Cache, see your Macintosh 
reference manual. Set RAM Cache for 64K or higher. 
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Installing Correct Grammar 
The Correct Grammar program and its associated files are contained 
on two disks. The disks contain an installation program that automat- 
ically installs Correct Grammar on the hard disk. 

If you do not have an earlier version of Correct Grammar on your 
computer, follow the steps below to install this version of Correct 
Grammar. — 

@ To install Correct Grammar: 

1 Insert the Correct Grammar Disk 1 into the disk drive. 

Note: Disk 1 may contain a Read Me First file. This file contains 
information that was developed too late to be included in the 
manual. Be sure to open this file and read it before continuing the 
installation. To open the file, just double-click the Read Me First 
icon. 

2 Double-click the Correct Grammar Installer icon. 

3 Follow the instructions on the screen. 

If You’re Upgrading from a Previous Version 

If you’re upgrading from a previous version (except any version of 
Correct Grammar 1.0), you can save the files containing your user dic- 
tionary, customized style guides, option preferences, and compiled 
user rules to use with the new version of Correct Grammar. To deter- 
mine whether you want to save these files, consider the following: 

User Dictionary The Correct Grammar user dictionary file contains 

the words you added with the Add button while using Correct 

Grammar, unless you have been sharing the MS Word user dictionary. 
If you have been sharing the Word user dictionary, that dictionary con- 
tains your added words and you don’t need to save the Correct 
Grammar user dictionary file. The Correct Grammar user dictionary 



Getting Started 

is named “User Dictionary” and is stored in the Correct Grammar 
Preferences folder. 

Style Guides If you customized any of the style guides, or developed 
your own, you may want to save them. Customized style guides are 
stored in the Correct Grammar Preferences folder. The names of the 
original style guides are listed in Chapter 4, “Customizing Correct 
Grammar.” 

Preferences This file contains your option choices and current stand- 
ard style guide. The Preferences file is stored in the Correct Grammar 
Preferences folder. 

CompiledRules This file contains the grammar rules you have 
written and compiled with the MakeRules application. The 
CompiledRules file is stored in the Correct Grammar folder. 

To save any or all of the above files from a previous version for use 
with this version of Correct Grammar, follow the steps below. 

@ To save files and install Correct Grammar: 

1 Inthe System folder, open the Correct Grammar Preferences folder. 

2 Drag the files you want to save out of the Correct Grammar 
Preferences folder and store them on the desktop. 

3 Close the Correct Grammar Preferences folder, and then close the 

System folder. 

4 If you want to save the rules you have written, open the Correct 
Grammar folder and drag the CompiledRules file to the desktop. 

5 Insert the Correct Grammar Disk 1 into the disk drive. 
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Installing Correct Grammar 

Note: Disk 1 may contain a Read Me First file. This file contains 
information that was developed too late to be included in the 
manual. Be sure to open this file and read it before continuing with 
the installation. To open the file, just double-click the Read Me 
First icon. 

Double-click the Correct Grammar Installer icon. 

Follow the instructions on the screen to install Correct Grammar. 

Double-click the Correct Grammar application icon to start Correct 
Grammar. Correct Grammar asks if you want to share MS Word’s 
user dictionary. 

If you use MS Word as your word processor, click the Yes button. 
If you use another word processing program, click the No button. 

Correct Grammar displays the Open dialog box. 

Choose Cancel to close the Open dialog box. 

Pull down the File menu and choose Quit. 

Correct Grammar creates a new Preferences folder in the System 
folder. 

If you are saving the CompiledRules file, drag it to the Correct 
Grammar folder. 

Open the System folder and drag the other saved files to the new 
Correct Grammar Preferences folder. This completes the 
installation and Correct Grammar is now ready to use. 

Note: If you are using System 6.0.8 or earlier, the Correct Grammar 
Preferences folder is located in the current System folder. If you 
are using System 7.0 or later, the Correct Grammar Preferences 
folder is located in the Preferences folder in the current System 
folder. 
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Installing Correct Grammar on a Network 

Correct Grammar can be installed and used ona network. If you want 
to use Correct Grammar on a network, you must obtain a network 
license agreement and installation instructions from WordStar® 
International Incorporated. 

About the Correct Grammar Files 

After you install Correct Grammar and open the Correct Grammar 
folder, you'll see the icons for the Correct Grammar application and its 
associated files. 

The Correct Grammar files are described below: 

Correct Grammar _ This is the application file. 

Learn CG and Tour CG Youcan use these files to learn how to use 

Correct Grammar and to see the kinds of errors Correct Grammar can 

help you fix. 

Launch CG You use this program to start Correct Grammar from 
within other folders or from the desktop. 

Read Me First This file contains last-minute information about using 
Correct Grammar. 

Using CG with MS Word This file contains information about using 
Correct Grammar with Microsoft Word. 

Using CG with WordPerfect This file contains information about 
using Correct Grammar with WordPerfect. 

Using CG with Others This file contains information about using 
Correct Grammar with other word processors and desktop publishing 
programs. 



Starting Correct Grammar 

MakeRules This is the application you use to compile the grammar 
rules you write. For more information, see Appendix C, “Writing 
Your Own Rules.” 

Correct Grammar Data This folder contains the style guides and 
dictionaries Correct Grammar uses to check documents. 

UserRules This file contains a template for writing new grammar 
rules. When you write your own grammar rules, you must write them 
in this file. For more information, see Appendix C, “Writing Your 
Own Rules.” | 

TeachText This is the Macintosh plain text (ASCII) word processing 
application. You use this application to read and print plain text docu- 
ments like the Read Me First file and the UserRules file. You also use 
TeachText (or another ASCII word processor) to write new rules in the 
UserRules file. 

The Read Me First File 
If you see a Read Me First file when you open the Correct Grammar 
folder, be sure to open and read it before using this version of Correct 
Grammar. Double-click the Read Me First icon or retrieve the file, 
which is a plain text document, with your word processor. The file 
contains any last-minute information about Correct Grammar that is 
not included in this manual. 

Starting Correct Grammar 
To start Correct Grammar, open the Correct Grammar folder and 
double-click the Correct Grammar icon or the Launch CG icon. You 
can also make Correct Grammar easier to use by setting up additional 
ways to start the program. Additional ways to start Correct Grammar 
are described in this section. 
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Note: When you start Correct Grammar for the first time, you'll be 
asked to choose a user dictionary for Correct Grammar to use. The 
steps for choosing a user dictionary are described later in this chapter. 

Starting with a Copy of Launch CG 

In addition to starting Correct Grammar as shown above, you can start 
Correct Grammar by using copies of the Launch CG program. You do 
this by placing copies of the Launch CG icon on your desktop or in 
various folders on your hard disk. For example, you might put copies 
of Launch CG in folders containing documents and in the folder con- 
taining your word processor. Then Launch CG is always available in 
the active window when you quit your word processor, and you 
won't need to search through folders to locate and start Correct 
Grammar. 

@ To make a copy of Launch CG: 

1 Open the Correct Grammar folder. 

2 Hold down the Option key, and drag the Launch CG icon to the 
desktop or to another folder. 

3 Release the mouse button. The computer copies the program and a 
copy of the Launch CG icon appears. 

You can make as many copies of Launch CG as you want, but you 
can put only one copy on the desktop and in each folder. 

To start Correct Grammar, double-click the Launch CG icon. 

Starting with an Alias 

If you are using System 7.0 or later, you can create aliases for the 
Correct Grammar application and put them wherever you want. Once 
you create a Correct Grammar alias, just double-click it to start Correct 
Grammar. 
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Starting Correct Grammar 

To create a Correct Grammar alias: 

Open the Correct Grammar folder. 

Select the Correct Grammar application icon. 

At the File menu, choose Make Alias. 

The alias icon appears with its name in italic type (you can edit the 
name if you want). 

Drag the alias icon to the desktop or to a folder. 

To start Correct Grammar, double-click the alias icon. 

Starting from the Apple Menu 
If you are using System 7.0 or later, you can start Correct Grammar 
from the Apple menu instead of having to find a Correct Grammar 
alias or Launch CG icon. 

S 

1 

To add Correct Grammar to the Apple menu: 

Create a Correct Grammar alias as described above in “Starting 
with an Alias.” 

Open the System folder, and drag the alias icon to the folder 
named Apple Menu Items. 

To start Correct Grammar, pull down the Apple menu and choose the 
Correct Grammar alias. 

Dragging to the Icon 

If you are using System 7.0 or later, you can start Correct Grammar 
and begin checking a document in one step. Just drag the icon of the 
document you want to check to a Correct Grammar alias or to the 
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Correct Grammar application icon, and then release the mouse button. 

If the document is a word processing document, Correct Grammar 

starts, opens the document, and begins checking it. 

Choosing a User Dictionary 

10 

The user dictionary is a special dictionary file that you use with 

Correct Grammar to check spelling. This file allows you to add words 

that a standard spelling dictionary might not recognize or words that 

might be flagged as misspellings (for example, trade names, company 

names, or names of individuals). 

Correct Grammar is designed to share the Microsoft Word user dic- 

tionary. If you use MS Word as your word processor, you can add 

words to its user dictionary using Word or Correct Grammar, and the 

words will be recognized as correct by both programs. If you do not 

use MS Word, Correct Grammar will use its own user dictionary. 

When you start Correct Grammar for the first time, you must select a 

user dictionary. You can also select a user dictionary using the 

Options menu. To start Correct Grammar for the first time and select 

a user dictionary, follow the steps in the procedure below. 

@ To select a user dictionary: 

1 Start Correct Grammar using one of the procedures described 

above. Correct Grammar displays a message asking if you want to 

share the MS Word user dictionary. 

2 If you are using MS Word as your word processor and you want 

Correct Grammar to share the Word user dictionary, click the Yes 

button. 

If you are not using MS Word as your word processor, click the No 

button. 



Learning About Correct Grammar 

Correct Grammar displays the Open dialog box so you can select a 
document to check. 

If you want to change your user dictionary later, see “Using a User 
Dictionary” in Chapter 3, “Choosing Options.” 

Learning About Correct Grammar 
The Correct Grammar folder contains two files, Learn CG and Tour 

CG, that can help you learn about Correct Grammar. 

Using Learn CG 

The Learn CG document is a tutorial that introduces you to Correct 
Grammar. You can use this file to learn, for example, how to correct 

mistakes Correct Grammar finds or how to ignore suggestions Correct 
Grammar makes. 

Learn CG contains a sample document that shows you how to use the 
Correct Grammar checking features. The document contains 
deliberate errors that Correct Grammar detects. Correct Grammar 
stops when it finds one of these errors. The tutorial describes the error 
and how Correct Grammar suggests correcting it. | 

The best way to learn about Correct Grammar is to read what Learn 
CG displays on your screen, and follow the instructions. 

® To use Learn CG: 

1 Open the Correct Grammar folder and double-click the Learn CG 
icon. Correct Grammar starts and begins checking the sample 
document. 

Note: If Correct Grammar is already started, choose Open from the 
File menu, find Learn CG in the list box, and double-click its icon. 

11 
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2 When Correct Grammar displays a suggestion, read the suggestion 

in the upper part of the screen, the explanation below it, and the 

Learn CG text in the lower part of screen. 

3 Click an Action button or choose a command from the Action 

menu to tell Correct Grammar what to do. 

When Correct Grammar finishes checking Learn CG, the Save 
dialog box appears. 

4 Click the Discard button. The Readability Summary appears. 

5 Click the OK button, and choose Quit from the File menu. Correct 

Grammar returns you to the desktop. 

Using Tour CG 

12 

The Tour CG file contains a short, poorly written letter. The purpose 
of the Tour file is to provide examples of errors Correct Grammar 
finds and show how it can help you correct them. For example, Tour 
CG shows you how Correct Grammar finds and corrects run—on sen- 
tences, verb agreement problems, split infinitives, redundancies, long 

noun strings, and spelling errors. 

Tour CG allows you to practice using Correct Grammar and to explore 

its power and versatility. When you start Tour CG, Correct Grammar 

automatically checks the document and stops when it finds a problem. 

If you’re not sure how to respond to the errors Correct Grammar 
finds, use Learn CG first and then come back to the Tour file. 

@ To use Tour CG: 

1 Open the Correct Grammar folder and double-click the Tour CG 
icon. Correct Grammar starts and begins checking the document. 



lf You Need Help 

Note: If Correct Grammar is already started, choose Open from the 
File menu. Find the Tour CG file in the list box and double-click its 
icon. Correct Grammar will start and begin checking the document. 

2 When Correct Grammar makes a suggestion, read the suggestion, 
the explanation, if any, and the Tour CG text. 

3 Click an Action button or choose a command from the Action 

menu to tell Correct Grammar what to do. 

When Correct Grammar finishes checking Tour CG, the Save 
dialog box appears. 

4 Click the Discard button. The Readability Summary appears. 

5 Click the OK button, and choose Quit from the File menu. Correct 

Grammar returns you to the desktop. 

If You Need Help 
Correct Grammar provides online help for the following: 

a» Using Action commands 

To get help with using Action commands, choose Help from the 
Action menu or click the Help button in the Action button bar in 
the Correction window. 

a Changing style guides 

To get help with changing style tea click the Help button in the 
Rule Classes dialog box. 

=” Changing readability rules 

To get help with changing readability rules, click the Help button 
in the Readability Rules dialog box. 
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System 7.0 Balloon Help 

If you are using System 7.0 or later, Correct Grammar provides help in 

balloons. You can turn on Balloon Help at any time by clicking the 

Help button. You can also turn on Balloon Help by choosing Show 

Help from the ? menu. As you move the mouse pointer to menu 

choices or buttons, windows, or boxes containing help, Correct 

Grammar displays the help information in balloons. To turn off 

Balloon Help, click the Help Off button or choose Hide Balloons from 

the ? menu. 

If You Have Problems 

14 

If you have problems installing or using Correct Grammar, and you 

cannot resolve them by reading this manual or the online help, contact 

WordStar Technical Support. For more information, see the WordStar 

Support Policy card in your Correct Grammar package. 

If you are a CompuServe subscriber, you can communicate with us 

through the Writing Tools section of the WordStar Forum (Go 
WordStar). 



Chapter 2 

Using Correct Grammar 

In this chapter, you'll learn how to 

Q Use Correct Grammar to check documents directly 

ag Use Correct Grammar to check documents on the Clipboard 

Correct Grammar checks documents in one of two ways depending on 
the word processor that created the document you’re checking. 

Here are the two ways Correct Grammar checks documents: 

a Correct Grammar checks documents directly. With this method, 
you use Correct Grammar to open your document and check it. If 
you make changes you want to save, Correct Grammar saves the 
changes directly to your document. With documents produced by 
several popular word processors, Correct Grammar preserves the 
page layout, formatting, fonts, and highlighting. You can also use 
the direct method to check documents produced in plain text 
(ASCII) format. 

To use Correct Grammar to check a document directly, see 
“Checking a Document Directly” later in this chapter. 

a Correct Grammar also checks document text on the Clipboard. 
With this method, you use your word processor to open the 
document and save all or part of it to the Clipboard. Then, you 
open the Clipboard with Correct Grammar and check the text. If 

19 



Using Correct Grammar 

you make changes you want to save, Correct Grammar saves them 
to the Clipboard and you use your word processor to paste the 
changes into your document. With documents produced by 
several word processors, Correct Grammar preserves the page 
layout, formatting, fonts, and highlighting. 

To use the Clipboard to check a document, see “Checking a 
Document Using the Clipboard” later in this chapter. 

Correct Grammar and Word Processors 
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Correct Grammar works with word processors and other text-produc- 
ing applications in different ways depending on whether Correct 
Grammar can read and write the native file format and the Clipboard 
file format of the word processor. There are five categories: 

Category 1 

You can open the document file using the Correct Grammar Open 
command, check the document, and save changes to the document in 

the original file format, retaining the formatting and style attributes 
(page layout, highlighting, fonts) of the original document. 

You can also exchange text between the document and the Clipboard 
using the Macintosh Copy and Paste functions. With Category 1 pro- 
grams, Correct Grammar can check text on the Clipboard and save 
changes to the Clipboard, retaining the formatting and style attributes 

of the original document. 

Category 2 

You can open the document file using the Correct Grammar Open 
command, check the document, and save changes to the document in 

the original file format, retaining the formatting and style attributes 
(page layout, highlighting, fonts) of the original document. (This is 
the same as Category 1.) 



Correct Grammar and Word Processors 

You can also exchange text between the document and the Clipboard 
using the Macintosh Copy and Paste functions. With Category 2 word 
processors, Correct Grammar can check text on the Clipboard and 
save changes to the Clipboard, but will not retain the formatting and 
style attributes of the original document. 

If you want to use the Clipboard to check grammar on Category 2 
documents, it is recommended that you check grammar before adding 
style and formatting attributes. 

Category 3 

You cannot open the document file using the Correct Grammar Open 
command. | 

You can exchange text between the document and the Clipboard using 
the Macintosh Copy and Paste functions. With Category 3 word pro- 
cessors, Correct Grammar can check text on the Clipboard and save 
changes to the Clipboard, retaining the formatting and style attributes 
of the original document. 

Category 4 

You cannot open the word processor’s document file using the Correct 
Grammar Open command. 

You can exchange text between the document and the Clipboard using 
the Macintosh Copy and Paste functions. With Category 4 word pro- 
cessors, Correct Grammar can check text on the Clipboard and save 
changes to the Clipboard, but will not retain the formatting and style 
attributes of the original document. 

If you want to use the Clipboard to check grammar on Category 4 
documents, it is recommended that you check grammar before adding 
style and formatting attributes. 

Category 5 

Correct Grammar can be used with word processors that can produce 
document files in plain text (ASCII) format. If you cannot use Correct 
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Grammar with your word processor using one of the methods 

described in categories 1-4, save your document in a plain text file and 

then check it with Correct Grammar using the direct checking method. 

(For more information, see “Checking a Document Directly” later in 

this chapter.) When you finish checking grammar, use your word pro- 

cessor to convert the document back to its original file format. You 

can open plain text (ASCII) files using the Correct Grammar Open 

command, check the document, and save changes to the document in 

the plain text file format. 

You can also exchange text between plain text files and the Clipboard 

using the Macintosh Copy and Paste functions. 

In addition to word processors, many other applications produce text 

documents that Correct Grammar can check. These applications 

include spreadsheets, databases, desktop utilities, and most modem 

communication programs. To check text documents produced by 

these applications, save the text you want to check in plain text 

(ASCID format and then check it using the direct checking method. 

The following table summarizes the word processor categories. 

To find out how Correct Grammar works with your word processor, 

see the files named “Using CG with MS Word,” “Using CG with 

WordPerfect,” or “Using CG with Others” in the Correct Grammar 

folder. 



Checking a Document Directly 

Checking a Document Directly 
~ When you check a document directly, Correct Grammar opens the 
document and saves changes directly to the document. The direct 
method also allows you to interrupt checking and resume checking 
later, starting in the same place in the document where you stopped 
earlier. The direct method allows you to switch between documents 
quickly and easily. 

Checking a document directly in Correct Grammar involves the fol- 

lowing tasks: 

a Opening a document using Correct Grammar 

a Checking grammar and spelling 

s Making changes in the document using Correct Grammar 

commands 

m™ Saving changes to the document 

Opening a Document 

You can open a document in one of the following ways: 

If you are using System 7.0 or later, start Correct Grammar and 
open a document by dragging its icon to the Correct Grammar 
application icon or an alias icon. Correct Grammar starts, opens 
the document, and begins checking. 

You can also start Correct Grammar by double- clicking the 
application icon or an alias icon or choose Open from the File 
menu. Correct Grammar displays the Open dialog box with the 
message Open document to check. 

Select the document you want to check and click the Open button. 
Correct Grammar starts checking the document. 

If you are using System 6.0.8 or earlier, start Correct Grammar by 
double-clicking either the application icon or a Launch CG icon, or 
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by choosing Open from the File menu. Correct Grammar displays 
the Open dialog box with the message Open document to check. 

Select the document you want to check and click the Open button. 

Correct Grammar starts checking the document. 

Note: If you are using Correct Grammar with MultiFinder, here is a 
point to remember: If you attempt to start Correct Grammar again 
while it is already running in the background, you will see the 
message Some ‘Correct Grammar’ documents could not be opened or 
printed. Please open the documents from within the application. 

To bring Correct Grammar to the foreground to check a document, 
click the MultiFinder icons in the menu bar until you see the 
Correct Grammar icon, or choose Correct Grammar from the 

Apple menu. 

Using the Correction Dialog Box 

When Correct Grammar starts, it displays the Correction dialog box. 

Learn CG (Default Style Guide) 

Some writers prefer to use ‘that’ rather than ‘which’ in restrictive 

(defining) relative clauses. If the relative clause is nonrestrictive, which’ 

should be preceded by a4 comma. 

Learning Correct Grammar: 
welcome to Correct Grammar (CG) and to our tutorial document gjium 

deliberate errors. CG flags each error by highlighting it. AT EACH ERROR, 

read this text. For this first example, replace “which” by clicking the 

Correct button. 

The title bar displays the name of the document and the current style 

guide being used to check the document. The Action button bar 

divides the dialog box in half. In the lower part of the dialog box, 
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Correct Grammar displays the text of the document being checked. In 
the upper part of the dialog box, Correct Grammar displays sugges- 
tions, choices, directions, and tutorial information. 

When Correct Grammar Makes a Suggestion 

When Correct Grammar finds an apparent problem in a document, it 
stops checking the document and displays the document text in the 
lower part of the screen, with the problem highlighted. In the upper 
part of the screen, Correct Grammar displays a suggestion for resolv- 
ing the problem. Depending on the type of suggestion, Correct 
Grammar may also display a list of choices and directions for resolv- 
ing the problem. 

Learn CG (Default Style Guide) 

If you don’t want to add a word to your user dictionary, just click Ignore. 

CG will recognize that word until the end of your session, when you quit CG. 

If you have deliberately misspelled a werd (sic), click on Skip 1X. Then CG 

Will flag any further occurrences of the @aGigm) as misspellings. 

When Correct Grammar makes a suggestion, you can do one of the 
following: 

= Use an action command to tell Correct Grammar what to do. 

= Click the Help button for information about your current choices. 

m Click the document text and make changes. 

= Double-click a replacement word from the spelling list. 
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Using the Action Commands 

The action commands tell Correct Grammar what action to take. The 

action commands appear on the Action menu and on buttons in the 

Correction dialog box and will vary, depending on the suggestion 

Correct Grammar makes. For example, the Look Up command 

replaces the Correct command when Correct Grammar makes a spell- 

ing suggestion. 

Action 

Correct 36 G 

ignore li 

Next aN 

Quiet 3€0 
EEE E: 8 FE 

Tutorial ST 
eu eeuteunounconepuacusenshwaunancotoonusancanensen 

To choose an action command, click the button or choose the com- 

mand from the Action menu. If a button is double-outlined, pressing 

the Return key causes the same action as clicking the button. You can 

also choose a command by using its keyboard equivalent. The key- 

board equivalents are displayed next to the commands on the Action 

menu. 

Use This 
Command To Do This 

Add Add the highlighted word to your user dictionary. 
The Add command appears when Correct Grammar 
questions the spelling of a word. 

If you are sharing the MS Word user dictionary, 
using the Add command adds the word to that 
dictionary. For more information, see “Choosing a 
User Dictionary” in Chapter 1, “Getting Started.” 



Use This 

Command 

Check 

Correct 

Help 

Ignore 

Look Up 

Next { 

Checking a Document Directly 

To Do This 

Resume checking the document, including the 
changes you just made. The Check command 
appears when you click in the text and start typing 
new text or deleting existing text. 

Insert the correction in your text and recheck the 
sentence. The Correct command appears when 
Correct Grammar displays a suggested correction. 

Get help with Correct Grammar. 

Tell Correct Grammar not to make the suggested 
change. Correct Grammar resumes checking. 

Using the Ignore command on a spelling suggestion 
causes the word to be accepted for the remainder of 
the grammar checking session. Use the Skip 1x 
command if you want Correct Grammar to skip the 
current instance but make the same spelling 
suggestion if the word occurs again. 

Note: If you want to turn off the rule that flags this 
error, use the Quiet command instead of Ignore. 

Ask Correct Grammar to make alternative spelling 
suggestions. The Look Up command replaces the 
Correct command when Correct Grammar finds an 
apparent misspelling. The spelling suggestions 
appear in a list above the Help button. 

Skip the current paragraph. Correct Grammar goes 
to the beginning of the next paragraph. To resume 
checking, use the Check command. 
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Use This 

Command 

Quiet 

Resume 

Skip 1x 

Tutorial 

To Do This 

Turn off the rule that Correct Grammar used to make 
the current suggestion. When you use the Quiet 
command, a dialog box appears that allows you to 
turn off the rule permanently or just for this 
grammar checking session. 

Note: If you use the Quiet command when a 
readability maximum has been exceeded, Correct 
Grammar displays the Readability Rules dialog box 
SO you can enter a new value. For more information, 
see “Customizing Readability Rules” in Chapter 4, 
“Customizing Correct Grammar.” 

Close the Tutorial window and return to the 
checking process. The Resume command replaces 
the Tutorial command after Correct Grammar 
displays the tutorial text. 

kip the current spelling problem this time only. 
Correct Grammar will highlight any future 
occurrences of the same problem. The Skip 1x 
command replaces the Tutorial command when 
Correct Grammar makes a spelling suggestion. 

Note: See the Quiet and the Ignore commands for 
other ways you can tell Correct Grammar to skip 
certain spelling problems. 

Display a tutorial lesson on the writing principle that 
applies to the current grammar suggestion. Ifa 
lesson is longer than one screen, you can scroll down 
or up using the scroll bar. When Correct Grammar 
makes a grammar suggestion, the Tutorial command 
replaces the Skip 1x command. 

When you finish the tutorial, use the Check 
command to resume checking your document. 



Checking a Document Directly 

Editing a Document 

Correct Grammar lets you edit a document during grammar checking. 
When Correct Grammar stops to make a suggestion, move the mouse 
pointer to the place you want to edit, and click. You can type new 
text, use the Delete, Backspace, or Clear key to remove characters or 

selected text, and perform other editing functions available on the Edit 
menu. For major text revisions, however, it is best to use your word 
processor. | 

When Correct Grammar stops with text selected (highlighted) and you 
begin typing, your characters replace the selected text. If you want to 
undo your changes and restore the original text, choose Undo Typing 
from the Edit menu. 

To make a paragraph revert to the form it had before editing, choose 
Revert from the Edit menu. 

Note: Correct Grammar retains smart (curly) quotes where they 
appear in your document, even if you change the text. You can also 
add smart quotes while editing in Correct Grammar. 

Scrolling a Document 

Correct Grammar reads a document from beginning to end; however, 
it reads only a part of the document at a time, in chunks of text. There- 
fore, while Correct Grammar is running, you cannot scroll backward 
in the document. If you need to go back to a previous page, close the 
document, saving changes if appropriate. Then reopen the document 
and use the Next { button to move forward to the text you want to 
check. 

Closing a Document 

While using Correct Grammar to check documents directly, you can 
open and close as many documents as you want. To close the current 
document, choose Close from the File menu or click the close box. If 
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you have made changes that you haven’t saved, Correct Grammar 
asks if you want to save them. 

Saving Your Changes 

While working in Correct Grammar, you can save your changes at any 
time. When you check a large document, it is a good idea to save revi- 
sions from time to time. After saving a document, you can continue 
checking the document or you can close the document and open 
another one. If you decide to close the document or quit Correct 
Grammar, and you haven’t saved the latest changes, Correct Grammar 
displays the Save Changes dialog box. 

The Save Changes dialog box commands are described below. 

Use This 

Command 

Save 

Discard 

Cancel 

Save As 
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To Do This 

Save changes and close the document, replacing the 
original document. If the Make Backup Document 
command (Options menu) is on, the original 
document is preserved with “(old)” added to the 
name. For more information, see “Making Backup 
Documents” in Chapter 3, “Choosing Options.” 

Abandon changes made with Correct Grammar and 
close the original document. 

Cancel the Save request and return to Correct 
Grammar without taking any action. 

Display the Save As dialog box. A message asks you 
to name the document. The document is saved with 
this name. The original document is preserved 
under its original name. 



Checking a Document Directly 

Interrupting the Checking Process 

You can interrupt Correct Grammar’s checking process if you want, 
and then resume checking the document later. Correct Grammar 
remembers where you interrupted grammar checking. When you 
reopen the document, Correct Grammar gives you the option of 
resuming where you stopped. You can interrupt the checking process 

in either of two ways: 

= If Correct Grammar has stopped analyzing text and is offering a 
suggestion, click the close box or choose Close from the File menu. 
Correct Grammar interrupts the checking process. 

If you have not made any changes to the document during the 
grammar checking session, Correct Grammar closes the window 
and saves the document. If you have made changes to the 
document, Correct Grammar displays the Save dialog box. You 
can save the changes, discard the changes, cancel the interruption 
process, or save the document under a new name. 

= If Correct Grammar has not stopped to offer a suggestion and is 
displaying the word “analyzing” in the Suggestion box, you can 
press 38 -. (period) to interrupt the grammar checking process. 
Then close and save the document. 

Resuming the Checking Process 

You can resume grammar checking where you left off only in the docu- 

ment you most recently saved with Correct Grammar, and only if you 
have not made any changes to the document since you last saved it. 

@ To resume checking the same document: 

1 Choose Open from the File menu and select the document again. 
Correct Grammar asks if you want to resume checking from where 
you stopped the last time. 
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2 Toresume checking at the point where you interrupted the 
process, click the Yes button. 

To begin checking at the beginning of the document, click the No 
button. 

Checking a Document Using the Clipboard 

28 

Use Correct Grammar with the Clipboard if you want a convenient 

way to edit your document or if your word processor is listed in one 

of the “Using CG with...” files as one that Correct Grammar works 

with only through the Clipboard. 

The Clipboard method allows you to check a document quickly and 

easily. You can copy any part or all of your document to the Clip- 

board, check it with Correct Grammar, and then paste the corrected 

text back into your document. 

Checking a document using the Clipboard involves performing the fol- 

lowing tasks: 

= Moving the text to be checked onto the Clipboard 

= Checking grammar and spelling with Correct Grammar 

= Making changes in the document using Correct Grammar 
commands 

= Pasting changes from the Clipboard into the document 

There are two ways to use the Clipboard with Correct Grammar to 

check a document. The one you choose depends on how you're using 

your computer. 



Checking a Document Using the Clipboard 

= If you are using the Macintosh multiple application management 

mode available in MultiFinder and System 7.0 or later, with 

enough RAM to run Correct Grammar and your word processor 

simultaneously, follow the steps in “Moving Text with Multiple 

Applications Running” in this chapter. 

= If you are using the standard single application mode, follow the 

steps in “Moving Text with One Application Running” in this 

chapter. 

Moving Text onto the Clipboard 

There are two ways to start grammar checking using the Clipboard. 

The one you choose depends on whether you are running Correct 

Grammar and your word processor simultaneously or running one 

application at a time. 

Moving Text with Multiple Applications Running 

Use this procedure if you are using MultiFinder or System 7.0 or later, 

and your computer has enough memory to run Correct Grammar and 

your word processor simultaneously. If your computer does not have 

enough memory for this procedure, follow the steps in “Moving Text 

with One Application Running” later in this chapter. 

@ To move text onto the Clipboard and begin grammar checking: 

1 Open the document with your word processor. 

2 Select the text you want Correct Grammar to check. (If you want to 

check the entire document, choose Select All from the File menu.) 

3 Copy the selected text to the Clipboard. 
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If Correct Grammar is already started, switch to it (Gif necessary) 
and choose Open Clipboard from the File menu. 

If Correct Grammar is not started, start it by double-clicking a 
Launch CG icon or Correct Grammar alias. Correct Grammar 

displays the Open dialog box. 

Click the Clipboard button. Correct Grammar begins checking the 
text on the Clipboard. 

Moving Text with One Application Running 

If you are not using MultiFinder or System 7.0 or later, or if your com- 
puter does not have enough memory to run Correct Grammar and 
your word processor simultaneously, you can still use the Clipboard 
to check documents with Correct Grammar. 

® To move text onto the Clipboard and begin grammar checking: 

1 Start your word processor and open the document you want 
Correct Grammar to check. 

Select the text you want to check. (If you want to check the entire 
document, choose Select All from the File menu.) 

Copy the text to the Clipboard. 

Quit your word processor. 

Start Correct Grammar. The Open dialog box appears. 

_ Click the Clipboard button. Correct Grammar begins checking the 
text. 



Checking a Document Using the Clipboard 

Using the Correction Dialog Box 

When Correct Grammar starts the checking process, it displays the 
Correction dialog box. 

Learn CG (Default Style Guide) 

Some writers prefer to use ‘that’ rather than ‘which’ in restrictive 

(defining) relative clauses. If the relative clause is nonrestrictive, ‘which’ 

should be preceded by 4 comma. 

Learning Correct Grammar: 

Welcome to Correct Grammar (CG) and to our tutorial document § 

deliberate errors. CG flags each error by highlighting it. AT EACH ERROR, 

read this text. For this first example, replace “which” by clicking the 

Correct button. 

The title bar displays the name of the document and the current style 
cuide being used to check the document. The Action command bar 
divides the dialog box in half. In the lower part of the dialog box, 
Correct Grammar displays the text of the document being checked. In 
the upper part of the dialog box, Correct Grammar displays sugges- 
tions, choices, directions, and tutorial information. 

When Correct Grammar Makes a Suggestion 

When Correct Grammar finds an apparent problem in a document, it 
stops analyzing document text, displays the text in the lower part of 
the screen, and highlights the problem. In the top part of the screen, 
Correct Grammar displays a suggestion for resolving the problem. 
Depending on the type of suggestion, Correct Grammar may also 
display a list of choices and directions for resolving the problem. 
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Learn CG (Default Style Guide) 

were 

weld 

ward 
wiih 

If you don't want to add a word to your user dictionary, just click Ignore. 

CG will recognize that word until the end of your session, when you quit CG. 

If you have deliberately misspelled a werd (sic), click on Skip 1%. Then CG 

will flag any further occurrences of the giieigy as misspellings. 

When Correct Grammar makes a suggestion, you can do one of the 

following: 

= Usean action command to tell Correct Grammar what to do. 

(For more information, see “Using the Action Commands” in 

“Checking a Document Directly” earlier in this chapter.) 

= Click the Help button for information about your current choices. 

ws Click in the document text window and make changes. 

= Double-click a replacement word from the spelling list. 

Editing Text on the Clipboard 
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Correct Grammar lets you edit text on the Clipboard during grammar 

checking. When Correct Grammar stops to make a suggestion, move 

the mouse pointer to the place you want to edit, and click. You can 

type new text, use the Delete, Backspace, or Clear key to remove char- 

acters or selected text, and perform other editing functions available 

on the Edit menu. For major text revisions, however, it is best to use 

your word processor. 



Checking a Document Using the Clipboard 

When Correct Grammar stops with text selected (highlighted), and 
you begin typing, your characters replace the selected text. If you 
want to undo your changes and restore the original text, choose Undo 
Typing from the Edit menu. 

Choose Revert from the Edit menu to make the paragraph revert to the 
form it had before editing. 

Note: Correct Grammar retains smart (curly) quotes where they 
appear in the text, even if you change the text. You can also add smart 
quotes while editing in Correct Grammar. 

Scrolling the Clipboard 

You can scroll the Clipboard text forward and backward as usual, 
once Correct Grammar has stopped with a suggestion or you have 
interrupted the checking process. 

Saving Changes 

When the checking process is finished, Correct Grammar closes the 
Clipboard and displays the Readability Summary (if that command is 
on). Click the OK button. 

If you did not make any changes in the text, you have finished check- 
ing grammar on this text. 

If you made changes to the text, those changes are now saved on the 
Clipboard. You must paste the changed text back into the document. 
There are two ways to paste changes from the Clipboard back to the 
document. | 

= If you are using the Macintosh multiple application management 
mode available in MultiFinder and System 7.0 or later, with 
enough RAM to run Correct Grammar and your word processor 
simultaneously, follow the steps in “Saving Changes with Multiple 
Applications Running” in this chapter. 
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= If youare using the standard single application mode, follow the 

steps in “Saving Changes with One Application Running” below. 

Saving Changes with Multiple Applications Running 

Use this procedure if you are running Correct Grammar and your 

word processor simultaneously. 

@ To paste changes from the Clipboard to the document: 

1 Open your word processor. Your original document and selected 

text are displayed. 

Make sure the original text you selected is still highlighted. (It 

should be selected unless you have deselected it accidentally.) 

2 Paste the revised text from the Clipboard into your document; it 

replaces the selected text. 

Saving Changes with One Application Running 

Use this procedure if you are not running Correct Grammar and your 

word processor simultaneously. 

@ To save changes from the Clipboard to the document: 

1 Choose Quit from the File menu to quit Correct Grammar. 

2 In your word processor, reopen the original document and select 

the text to be replaced. (The text you originally selected is no 

longer selected because you quit the application.) 

3 Paste the text from the Clipboard into the original document. The 

revised text replaces the selected text. 

Interrupting the Checking Process 

You can interrupt the Correct Grammar checking process if you want, 

_ and then close the Clipboard or quit Correct Grammar. You can 
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resume checking the Clipboard later. When you reopen the Clip- 
board, Correct Grammar starts checking the text at the beginning. You 
can interrupt the checking process in either of two ways. 

= If Correct Grammar has stopped analyzing text and is offering a 
suggestion, click the close box or choose either Close or Quit from 
the File menu. Correct Grammar interrupts the checking process, 
closes the window, and saves the Clipboard. If the Display 
Readability Summary command is on, the summary is displayed. 
Click the OK button. If you chose Quit, Correct Grammar quits 

and returns you to the desktop. 

= If Correct Grammar has not stopped to offer a suggestion and is 
displaying the word “analyzing” in the Suggestion box, you can 
press 3€ -.(period) to interrupt the grammar checking process. 
Then close the document or quit Correct Grammar as described 
above. 

The Clipboard saves the text until you copy other text to it (by using 
38 - C). The Clipboard text is also lost when you turn off your com- 
puter. To avoid losing changes you have made with Correct 
Grammar, you must do one of the following: 

= Paste the Clipboard text into the original document, as described in 
“Saving Changes” earlier in this chapter. 

= Open anew document with your word processor. Then paste the 
Clipboard text into it to save the changes until you resume 
grammar checking. 
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Tips on Working with Correct Grammar 
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Here are some tips to help you work with Correct Grammar: 

= If you think Correct Grammar has missed an error it should have 
found, check the Rule Classes dialog box to see if any rule classes 

are turned off. For more information, see “Customizing a Style 
Guide” in Chapter 4, “Customizing Correct Grammar.” 

If Correct Grammar does not seem to be finding any errors, pull 
down the Options menu and verify that the Analyze Readability 
Only option is turned off. For more information, see “Checking for 
Readability Only” in Chapter 3, “Choosing Options.” 

If your document is typed in all capital letters, Correct Grammar 
checks for spelling errors only and makes no grammar suggestions. 

If Correct Grammar opens a document but displays blank 
windows, it usually indicates a conflict with a screen-oriented 
INIT. Disable any INIT that you suspect of conflicting with Correct 
Grammar, restart your computer, and open the same document 
again. There are known conflicts with the INITs named “Gun,” 
“Oliver’s Button,” and “ClickChange.” WordStar International is 
currently working to resolve these conflicts. 



Chapter 3 

Choosing Options 

In this chapter, you'll learn how to 

a Use the Options menu so that Correct Grammar checks your 
documents according to your preferences 

a Use the Options menu to control how Correct Grammar checks 
your documents for readability 

Using the Options Menu 
To display the Options menu, start Correct Grammar and click 
Options in the menu bar. 

Options 

“Make Backup Document 

Automatic Spelling Suggestions 

Share M§ Word User Dictionary... 

Emphasize Related Errors... 

“Display Readability Summary 

Write Readability Summary File 

Analyze Readability Only 

Language... 
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Choosing Options 

The commands on the Options menu are either on or off. (Exceptions , 
are the Emphasize Related Errors and Language commands, which 
display dialog boxes when chosen.) 

Note: The Language command is available only in the International 
version of Correct Grammar.) 

A check mark next to a command means the command is on. The 
Make Backup Document and Display Readability Summary com- 
mands are on when you start Correct Grammar for the first time. 

Choosing a command toggles it on and off. To turn a command on or 
off, drag the mouse pointer to the command to highlight it, and then 
release the mouse button. The check mark disappears to indicate that 
the command is off. To turn the command on again, simply choose it 
again. 

The following sections describe how to use the Options commands to 
tell Correct Grammar how to proceed with document checking. 

Making Backup Copies of Documents 
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When the Make Backup Document command is on, Correct Grammar 
makes a backup copy of your word processing document each time it 
checks the document. Having a backup copy of your document 
ensures that you can go back to the previous version of the document, 
even though you may have saved changes to the current version. 

Correct Grammar stores the backup copy of a document in the same 
folder as the current document. The backup copy has the same name 
as the previous document with (old) appended to it. For example, the 
backup copy of a document named MyText would be named 
MyText(old). 



Requesting Automatic Spelling Suggestions 

Requesting Automatic Spelling Suggestions 
When Correct Grammar finds a spelling error in your document, it can 
either display a Look Up command that you can use to request alterna- 
tive spelling suggestions or it can automatically display the spelling 
suggestions. 

When the Automatic Spelling Suggestions command is on, Correct 
Grammar displays spelling suggestions each time it finds a possible 
spelling error. When the Automatic Spelling Suggestions command is 
off, you have to use the Look Up command to see the spelling sugges- 
tions. Turn this command off if you want Correct Grammar to display 
alternative spellings only when you request them. You may find this 
preferable when the document contains many specialized words that 
aren’t in your spelling dictionary. 

Using a User Dictionary 
When you first started Correct Grammar after installing it, you chose a 
user dictionary for Correct Grammar to use to check spelling. You can 
change that choice by using the Share MS Word User Dictionary com- 
mand on the Options menu. 

® To select a new user dictionary: 

1 Pull down the Options menu. 

If Correct Grammar is sharing the MS Word user dictionary, a 
check mark appears next to the command Share MS Word User 
Dictionary. If no check mark appears, it means Correct Grammar 
is using its own user dictionary. 

2 Choose the Share MS Word Dictionary command from the Options 
menu. 

39 



Choosing Options 

If you have been sharing the MS Word user dictionary, the check 
mark disappears and Correct Grammar begins using its own user 
dictionary. 

If you have been using the Correct Grammar user dictionary, the 
Open dialog box appears. 

Locate the MS Word folder that contains the user dictionary. (The 
dictionary may be named “Custom Dictionary.”) 

Select the MS Word user dictionary file and click the Open button. 
Correct Grammar closes the dialog box and begins sharing the MS 
Word user dictionary. 

Deleting or Changing a Word in the User Dictionary 

If you are using the Correct Grammar user dictionary, you can delete 
or change a word that you have added. 
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© To delete or change a word in the user dictionary: 

7 

2 

Quit Correct Grammar. 

Open the Correct Grammar Preferences folder. 

If you are using System 6.0.8 or earlier, this folder is located in the 
System folder. If you are using System 7.0 or later, this folder is 
located in the Preferences folder in the System folder. 

Drag the User Dictionary icon to the desktop. 

Double-click the User Dictionary icon. 

_ Correct Grammar starts, displays the Correction window, and 
opens the dictionary. 



10 

17 

12 

Using a User Dictionary 

Each word in the user dictionary will be flagged as a possible 

misspelling since Correct Grammar no longer has a user dictionary 

to use. 

Move the insertion point to the word you want to delete or change. 

To delete a word, select the word and the entire line it is on, and 

press the Delete key. 

To change a word, delete or add letters or characters as necessary. 

Choose Quit from the File menu. The Save Changes dialog box 

appears. 

Click the Save As button or press Return to save the dictionary 

changes. The Save As dialog box appears. 

Click the Save button. Correct Grammar displays the message 

Replace existing ‘User Dictionary?’ 

Click the Yes button. Correct Grammar displays the Readability 

summary, if that command is on. 

Click the OK button. Correct Grammar returns you to the desktop. 

Drag the User Dictionary icon to the Correct Grammar Preferences 

folder, and close the folder. 

Adding a Word to the User Dictionary 

You can add special words and special constructions, such as abbrevia- 

tions, to the Correct Grammar user dictionary. 

TIP If you have many words to add, you can save time by creating a 

special document containing the words you want to add. 
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@ To add a word to the user dictionary: 

7 Start Correct Grammar and open a document containing the 
word(s) you want to add. 

2 When Correct Grammar suggests that the word may be misspelled, 
click the Add button. 

3 When you finish adding words, quit Correct Grammar. Correct 
Grammar adds the words to the user dictionary. 

Adding Abbreviations to the User Dictionary 
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To Correct Grammar, a period indicates the end of a sentence. There- 
fore, if you use an abbreviation that ends with a period, (for example, 

“Ibs.”) Correct Grammar flags the abbreviation. You can avoid this 
by adding the abbreviation to the user dictionary. 

@ To add an abbreviation to the dictionary: 

1 Replace the period with another character, such as “z”. 

2 Add the word to the user dictionary using the steps in “Adding a 
Word to the User Dictionary” above. In this example, add the 
word “Ibsz’”’. 

3 Replace the “z” with a period using the steps in “Deleting or 
Changing a Word in the User Dictionary” above. 

Note: If Correct Grammar displays the message Internal user dictionary 
full, it means your dictionary is too large for the space allowed in 
Correct Grammar. Contact WordStar Technical Support to find out 
how to adjust Correct Grammar for a larger user dictionary. 



Emphasizing Related Errors 

Emphasizing Related Errors 
When Correct Grammar makes a grammar suggestion that involves 
two words, such as the agreement of a subject and a verb, it displays 
the related words with different highlighting. For example, in the 
screen below, notice the differences in the highlighting. 

Learn CG (Default Style Guide) 

Sentences like the previous one have a disagreement between the subject 

(problems) and the verb (is). Fixing either one will create a grammatically 
correct sentence, but only one will result in the sentence you want. In 

such cases you may need to click Ignore for the first suggestion, and then 

you will see the appropriate suggestion, changing “is” to “are.” Then click 

Correct to fix the text. 

You can use the Emphasize Related Errors command to choose the 
type of highlighting you want Correct Grammar to use on related 
words. 

@ To make highlighting choices: 

1 Atthe Options menu, choose the Emphasize Related Errors 
command. The Related Error Emphasis dialog box appears. 

Related Error Emphasis 

[] Italic 

i] Underline 

E] Outline 

E<] Shadow 

[] Condense 

[] Extend 
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2 Click the check boxes for the types of highlighting you want. 

3 Click the OK button or press Return to save your choices. 

If you are using a color monitor, you can change the colors used in the 

highlighting. 

@ To change the highlighting color: 

1 Inthe Related Error Emphasis dialog box, click the Color box. The 

Color Wheel dialog box appears. 

Choose an Emphasis Color 

— 
Hue |}21546 

Saturation | 46917 

Brightness 65535 _ 

Red 

G 
ag 
G 

oom 

Green 

plue [19619 _|8} 

2 Inthe color wheel, click the color (hue) you want used for 

highlighting related errors. The color appears in the sample color 

box in the upper-left corner of the dialog box. 

You can also select the hue by changing values in the Hue box. 

Click the Hue box and type the new value. Or you can click the Up 

or Down arrows to increase or decrease the values. (The range is 

0-65535.) 
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3 Inthe color wheel, click the desired color saturation. (The greatest 
saturation is at the outer edge of the color wheel.) 

You can also select the saturation by changing the values in the 
Saturation box. Click the Saturation box and type the new value. 
Or click the Up or Down arrows to increase or decrease the values. 
(The range is 0-65535. Zero is white (no color); 65535 is maximum 

color saturation.) 

4 Select the desired brightness by sliding the scroll bar or changing 
the value in the Brightness box. 

To change the value, click the box and type the new value. Or click 
the Up or Down arrows to increase or decrease the values. (The 
range is 0-65535; 65535 is maximum brightness.) 

5 Click the OK button or press Return to save the changes. 

Checking Documents for Readability 
The readability of a document is determined by many factors, includ- 
ing the length of paragraphs, sentences, and words, and the use of pas- 
sive voice in the document. (For more information about readability 

and how Correct Grammar checks for it, see Appendix B, “The Philos- 

ophy and Methodology of Correct Grammar.”) 

During a grammar check, Correct Grammar identifies the portions 
of your document that may cause readability problems. Correct 
Grammar can also display a summary of the readability problems in 
the document. This readability summary can help you determine if 
your document is appropriate for its intended audience. 
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Correct Grammar Readability Analysis 

Paragraphs : 

Sentences : (4.2 per paragraph) 

Words : (15.0 per sentence) 
Letters: (4.7 per word) 
Syllables per 100 words: 

Passive sentences : (4 % passive] 

Long sentences: (O % long) 

Misspelled words: (100 % correct) 
Sentences fixed: (100 % correct) 

Sentences hard to read: (100 % correct) 

Flesch Reading Ease score: (Easy) 

Grade level required: (89 % of U.S. adults) 

Flesch-Kincaid grade level: 

Gunning Fog Index: 

Displaying the Readability Summary 

You may want to request a summary of a document’s readability 
before Correct Grammar begins checking the document for grammar 
and spelling errors. Then, when Correct Grammar finishes checking 
the document, it either displays the summary, or saves it to a file so 
you can review or print it later. 

To ask Correct Grammar to display a readability summary after check- 
ing a document, turn on the Display Readability Summary command 
on the Options menu. Then select the document you want to check. 
Correct Grammar automatically displays the summary when it 
completes the checking process. 

Saving the Readability Summary 
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You can ask Correct Grammar to save a readability summary in a file. 
When the Write Readability Summary File command on the Options 
menu is turned on, Correct Grammar saves the summary as a docu- 
ment in the same folder as the checked document. The summary docu- 
ment has the same name as the checked document followed by (Stats). 



Checking Documents for Readability 

For example, a readability summary for a document named MyText 
would be saved in a file called MyText(Stats). 

Once you save a readability summary for a document, Correct 
Grammar saves the next readability summary for that document in the 
same Stats file, without erasing the previous summary. Each new 
readability summary is added to the end of the previous summary. 
This allows you to compare the new summary to previous Summaries 
so you can review the effects of your editing on the document’s 
readability. 

® To write a readability summary file: 

1 Pull down the Options menu and turn on the Write Readability 
Summary File command. 

2 Choose Open from the File menu and select the document you 
want to check from the list box. 

3 Click the Open button and check the document normally. Correct 
Grammar automatically writes the summary file when it completes 
the checking process. 

Printing the Readability Summary 

To print a readability summary, first create a Stats document by 
saving the summary as described above. Then open the Stats docu- 
ment with your word processor and print it. 

Checking for Readability Only 

You can choose the Analyze Readability Only command to limit 
Correct Grammar to checking your document for readability only. 
Checking for readability only is quicker than checking for grammar 
errors and readability in your document. 

When the Analyze Readability Only command is on, Correct 
Grammar does not stop to identify spelling or grammatical errors, 
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but checks for readability only. It also displays a readability summary 

when it completes the checking process. 

When the Analyze Readability Only command is off, Correct 

Grammar checks the document for spelling and grammar, stopping 

to make suggestions when it finds an apparent problem. 

®@ To check readability only: 

1 Pull down the Options menu and turn on the Analyze Readability 

Only command. 

2 Choose Open from the File menu and select the document you 

want to check from the list box. 

3 Click the Open button. Correct Grammar checks readability only 

and displays a summary when it completes the checking process. 

Making a Language Choice 

48 

If you’re using the International version of Correct Grammar, the 

Options menu contains the Language command. 

This command tells Correct Grammar whether to check for American 

English or British English spellings. You can also specify whether 

“_ise” or “-ize” will be used for word endings. If you specify “-ise” for 

word endings, Correct Grammar will flag “-ize” endings. 

If you choose British English, Correct Grammar will suggest British 

spellings instead of American (for example, “colour” instead of 

“color,” or “aeroplane” instead of “airplane”). Correct Grammar will 

also suggest the British form for compound words, such as 

“non-smoking” instead of the American form “nonsmoking.” 



Making a Language Choice 

@ To choose American or British English spellings: 

1 Choose Language from the Options menu. The Language dialog 
box appears. 

Language-specific options 

@ American Dictionary 

(> British Dictionary 

() Require -i4p seHings 

(J Regie -izve +peilings 

2 Select American Dictionary or British Dictionary. 

3 Click the OK button to save your settings. 
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Chapter 4 

Customizing Correct 
Grammar 

In this chapter, you'll learn how to 

a Customize Correct Grammar by choosing a predefined style guide 

a Customize a style guide to fit your writing style 

You can customize the way Correct Grammar checks documents by 
choosing a predefined style guide designed for specific types of writ- 
ing or by modifying a style guide to more closely fit your writing style. 

You can choose a style guide that fits your writing style and makes 
suggestions that complement that style. For example, if you are writ- 
ing an academic paper, you might choose the Academic style guide, 
which checks for formal language. Or, if you are writing fiction, you 
might choose the Fiction style guide, which allows you more freedom 
to express yourself. 

The predefined style guides provide you with different levels of gram- 
mar and readability checking, but you are not limited to those styles. 
You can change styles as often as you like and you can customize style 
guides. 
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Customizing Correct Grammar 

Deciding on a Predefined Style Guide 
A style guide consists of a set of grammar rules and a set of readability 

rules that Correct Grammar uses to check documents. 

Before deciding on a predefined style guide, you should do the 
following: 

= Display the list of predefined style guides. 

= Read the descriptions of the predefined style guides in this section. 

= Review the settings for grammar and readability rules for each 
style guide. 

Displaying the List of Predefined Style Guides 
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The list of predefined style guides appears on the Rules menu. To dis- 
play the list, pull down the Rules menu. (Hold down the mouse but- 
ton to keep the Rules menu displayed.) 

Open Style Guide... 

Save A Copy of Style Guide As... 
PPPTTTTITITITTTITTTiTirriririii iter) 

PPPTTTTTTTTTITTITTTTTTITrerrriirreiiriree er) 

Academic 

Advertising 

Basics 

Business 

Custom 

Fiction 

Informal 

Legal 

Readability (ONLY) 
Reviewer 

Technical 



Deciding on a Predefined Style Guide 

A check mark appears next to the name of the style guide that is cur- 
rently active. If you customize style guides, the Rules menu displays 
them also. Customized style guides are grouped at the top of the style 
guide list, in the same section as the Default style guide. 

The predefined styles are described below. 

Style Name 

Default 

Academic 

Advertising 

Basics 

Business 

Custom 

Fiction 

Informal 

Legal 

Readability 
(only) 

Reviewer 

Technical 

Description 

This style guide is selected the first time you start 
Correct Grammar. The Default style guide is the 
strictest style guide, with all grammar rules turned 
on. 

Very formal. 

Allows for creative freedom. 

Very informal. 

Allows some informality, including cliches (“the 
bottom line is”). Allows the use of some passive 
voice. 

Strict. You can customize this style guide to 
complement your own writing style. 

Allows for creative freedom. 

Very relaxed; the least strict style guide. 

Allows for characteristics of legal writing, such as 
long sentences. 

Checks readability only. All spelling rules and most 
grammar rules are turned off. 

Very strict. All grammar rules are turned on. 
Readability rules are relaxed. 

Allows for complex material and the use of passive 
voice. 
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Reviewing Rule Settings 

The settings for the grammar and readability rules used in the prede- 

fined style guides are displayed in the Grammar Rules dialog box and 
the Readability Rules dialog box associated with each style guide. 

54 

© To review the grammar rule settings of a style guide: 

1 Pull down the Rules menu, and choose the style guide you want to 

review. 

2 Press 3€-R or pull down the Rules menu and choose Review Style 

Style Guide : Default 

Spelling & Format 

Spelling 

Punctuation 

Capitalization 

Proper nouns 

Variants 

Format 

Mult. words 
ence 

Fragments 

Fun-on 

And/Or “But... 

and... and 

Misplaced ; 

Question ? 

Fassive-main 

Passive-subord. 

Usage 

Jargon 

wise ize 

Cliche 

Redundant 

wordy 

Pretentious 

Colloquial 

Informal 

Well- 

Archaic 

Weak 

Misused 

Confused 

Which ’that 
Nuances 

Beginner 

Guide. The Grammar Rules dialog box appears. 

Core Grammar 

Noun group consistency 

Verb group consistency 

Subject-verb agreement 

Ungrammatical sayings 

Mass and count misuse 

Pronouns, prepositions 

Multiple negation, etc. 

Miscellaneous 

Readability Rules... Hestere | 
j iegiet4 if: 

£ HSS 

£iese HR 

f£iane HPT 

The Grammar Rules dialog box displays the grammar rule settings for 
the current style guide. Correct Grammar uses thousands of rules to 
check grammar. These rules are grouped into rule classes and dis- 
played by type, as follows: . 

Sentence 

Core Grammar 

Spelling and Format 



Deciding on a Predefined Style Guide 

A bullet in front of a rule class name means that all rules in that class 
are active for the current style guide. A hollow diamond in front of a 
rule class name means that at least one rule is turned off in that rule 
class. If no bullet appears in front of a rule class name, it means that 
all rules in that class are turned off for the current style guide. For 
more information about the grammar rules settings, see “Customizing 
a Style Guide” later in this chapter. 

@ To review the readability rules settings: 

1 Pull down the Rules menu, and choose the style guide you want to 
display. 

2 Press 3€-R or choose Review Style Guide from the Rules menu. 
The Grammar Rules dialog box appears. 

3 Click the Readability Rules button. The Readability Rules dialog 
box appears. 

Split Infinitives C> All OK 

@ "...to boldly go..." not OK © "...t0 rather boldly go..." 

"...to not very boldly go..." © "...ta not at all boldly go..." 

Consecutive Nouns C) All OK 

("...0ffice automation division..." not OK 

("office automation database division..." 

(3 ",..0ffice automation database development division..." 

Prepositional Phrases ©) Al OK 

()"...in a ship at the bottom of the sea..." not OK 

(@"...in the hold of a ship at the bottom of the sea..." 

(> "...in a jarin the hold of a ship at the bottom of the sea..." 

Words in Sentence: Grade Level: 

Grammar Rules... [ Help || Peering it | Pirk4 Reaes}aey: | Cancel 

The Readability Rules dialog box displays the settings for the current 
style guide’s readability rules. The settings limit the number of words 
allowed in a split infinitive, the number of consecutive nouns allowed 
in a phrase, and the number of words and consecutive prepositional 
phrases allowed in a sentence. Grade Level sets the maximum reading 
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erade level of your target audience. For more information about the 
readability rules settings, see “Customizing Readability Rules” later in 
this chapter. 

Choosing a Predefined Style Guide 

06 

Choose the style guide that is appropriate for the document that 
you want to check. However, if you check multiple documents that 
require the same style, you don’t need to choose a style each time; 
Correct Grammar remembers which style guide was the last one used 
and uses it for the next document. 

@ To choose a predefined style guide: 

1 Pull down the Rules menu. 

2 Choose the style guide you want. 

The style guide you select becomes the current style. On the Rules 
menu, a check mark appears next to the new style guide. Correct 
Grammar uses that style to check your documents. 

Correct Grammar stores predefined style guides in the Correct 
Grammar Data folder and displays them on the Rules menu automat- 
ically. If you store a style guide outside the Correct Grammar folder, 
you can select that style guide by using the Open Style Guide 
command. 

® To choose a style guide stored outside the Correct Grammar Data 
folder: 

1 Pull down the Rules menu and choose Open Style Guide. The 
Open dialog box appears. 

2 Select the style guide from the folder where it is stored. 

3 Click the Open button. Correct Grammar chooses the style guide 
and closes the dialog box. 



Customizing a Style Guide 

Setting a Standard Style Guide 

If you change style guides during a grammar checking session, and 
then quit Correct Grammar, Correct Grammar asks if you want to 
make the latest style guide your standard style. If you respond “Yes,” 
the style remains the same for all subsequent grammar checking ses- 
sions (until you choose a different style guide). If you respond “No,” 
Correct Grammar returns to the previous standard style guide. If you 
rename or discard the standard style guide, Correct Grammar uses the 
Business style guide. 

Customizing a Style Guide 
One of the most useful features of Correct Grammar is that you can 
change a style guide to make choices about how Correct Grammar 
checks your documents. You can turn off a specific grammar rule or 
an entire rule class, and you also can modify readability rules. 

Grammar Rule Classes 

Since Correct Grammar allows you to turn off rule classes, it is impor- 
tant to understand. what each rule class does. The rule classes are 
described below. 

Spelling and Format Rule Classes 

These rule classes contain the rules Correct Grammar uses to check 

spelling, punctuation, capitalization, and formats. 

Rule Class What It Does 

Spelling Checks the spelling of words in your documents. 

Punctuation Checks punctuation in your documents. 

Capitalization Checks for capitalization errors, especially words 
that begin a sentence. 
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Rule Class What It Does 

Proper Nouns Checks for capitalization of proper nouns. 

Variants Checks for spelling variants. When more than one 
spelling is technically correct, Correct Grammar tells 
you which is preferred. This rule class also checks 
for correct spelling of common foreign phrases, such 
as “a capella.” 

Format Checks the format of dates, compound numbers, 
times, and abbreviation punctuation. 

Mult. words Checks for words that are also words when split, 
such as “everyone,” “awhile, and ”anymore.” 

Sentence Rule Classes 

These rule classes contain rules that Correct Grammar uses to check 

sentence structure and voice. 

Rule Class What It Does 

Fragments Checks for incomplete sentences. 

Run-on Checks for run-on sentences. A run-on sentence 

often contains multiple sentences separated by 
commas. 

And/Or/But Checks for sentences that begin with “And,” “Or,” 

or “But.” 

and...and Checks for sentences that contain two consecutive 

clauses beginning with “and.” 

Misplaced ; Checks for occurrences of a semicolon where a 
: comma would be more correct. 

Question? Checks for sentences consisting only of a relative 
clause beginning with a question word and not 
ending with a question mark. 
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Rule Class 

Passive - main 

Passive - 

subord. 

Customizing a Style Guide 

What It Does 

Checks for passive voice in the main clause. For 
example, for the sentence “The car was driven by 

John,” Correct Grammar suggests “John drove the 
yy 

Car. 

Checks for passive voice in a subordinate clause. 

Usage Rule Classes 

These rule classes contain rules that Correct Grammar uses to check 

word usage. 

Rule Class 

jargon 

...WISE,...1Z€ 

Cliche 

Redundant 

Wordy 

Pretentious 

Colloquial 

Informal 

Well- 

What It Does 

Checks for jargon, such as “bottom line” and 
“feedback.” 

Checks for words that have a nonstandard “-wise” or 

“-ize” suffix such as “personnelwise.” 

Checks for cliches such as “cutting edge” and “point 
blank.” 

Checks for redundant phrases such as “past history” 
and “these same.” 

Checks for wordy expressions such as “a half a” and 
“point in time.” 

Checks for pretentious word usage such as 
“orientate” and using “author” as a verb. 

Checks for nonstandard intensifiers such as “real” 

and “awful.” 

Checks for extremely informal expressions such as 
“this here,” “try and,” and “inside of.” 

Checks for nonstandard usage of “well-” as a prefix. 
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Rule Class 

Archaic 

Weak 

Misused 

Confused 

Which/that 

Nuances 

Beginner 

What It Does 

Checks for archaic words such as “whence” and 

“henceforth.” 

Checks for weak modifiers that detract from 

meaning, such as in the phrases “awfully hard,” 
“considered opinion,” and “past achievements.” 

Checks for misused words, such as in the phrase “is 
comprised of.” 

Checks for commonly confused words, such as in the 
phrase “The bride stood at the alter.” 

Checks for proper word choice to introduce 
restrictive (that) and nonrestrictive (which) clauses. 

Checks for words that are similar in meaning but 
different in nuance such as “adverse” and “averse.” 

Checks for mistakes beginning writers commonly 
make, such as confusing “bazaar” and “bizarre” or 

“right” and “rite.” These rules are intended for 
writers who are learning English as a second 
language. 

Core Grammar Rule Classes 

The Core Grammar rule classes form the fundamental rules of gram- 
mar by which Correct Grammar operates. These rule classes cannot be 
turned off, since doing so would undermine the basic usefulness of 
Correct Grammar. However, individual rules in these rule classes can 

be turned off. For more information, see “Turning Off a Grammar 
Rule” later in this chapter. 

Using the Grammar Rules Dialog Box 

A Rule Class may contain hundreds of different but similar rules. 
Turning off one rule will not prevent Correct Grammar from making 
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other apparently similar suggestions. For example, turning off the 

rule that flags one phrase as “wordy” will not stop Correct Grammar 

from flagging other similar wordy phrases. To turn off all such similar 

rules, you must turn off the entire rule class. 

You can use the Grammar Rules dialog box to turn off grammar rules 

and grammar rule classes. The name of the current style guide ap- 

pears in the upper-left corner of the dialog box. The current grammar 

suggestion (if any) is displayed below the style guide name. 

The Command Buttons 

The command buttons in the Grammar Rules dialog box are described 

below. 

Use This 

Command To Do This 

Rule Off Disable the specific rule that triggered the current 
suggestion. If you select this option, the rule class 
will be marked with a hollow diamond to indicate 

that one or more rules are turned off in that rule class. 

Class On Turn on a rule class that has been turned off. All 

rules in that class that were turned off with the Rule 

Off command or the Quiet command will remain off 

when the class is turned on again. 

Class Off Turn off all rules in the rule class. (Core Grammar 

rule classes cannot be turned off.) 

Restore Rules _ Restore (turn on) rules that were turned off using the 

in Class Quiet command or the Rule Off command. This 

command does not turn on a rule class that has been 

turned off. See “Class On” above. 

Cancel Cancel any changes you may have made and return 

Correct Grammar to your document to continue 

checking. 
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Use This 

Command 

This Session 

Permanent 

Readability 
Rules 

To Do This 

Tell Correct Grammar to use your style guide 
changes for this session of grammar checking only. 
The next time you start Correct Grammar, it will use 
the style guide settings that were in effect prior to the 
current changes. 

Save your style guide changes permanently (or until 
you change them again). These changes will be in 
effect the next time you start Correct Grammar. 

Close the Grammar Rules dialog box and open the 
Readability Rules dialog box. 

Turning Off a Grammar Rule 

Correct Grammar allows you to turn off the rule that was used in 
making the current suggestion for revising your sentence. Rules can 
be turned off using the Rule Off command in the Grammar Rules 
dialog box or the Quiet command in the Correct Grammar Correction 
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dialog box. 

® To turn off a rule using the Rule Off command: 

1 Press #-R or pull down the Rules menu and choose Review Style 
Guide. The Grammar Rules dialog box appears. The rule class 
containing the flagged rule is highlighted. 

2 Click the Rule Off button. A hollow diamond replaces the bullet 
next to the Rule Class name, indicating that at least one rule in the 
rule class is turned off. 
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3 If you want to turn off the rule permanently, click the Permanent 
button. 

If you want to turn off the rule for this grammar checking session 
only, click the This Session button. 

Correct Grammar resumes checking your document. 

CAUTION Use caution in turning off rules permanently. Individual 
rules cannot be turned back on except by restoring all rules in the rule class. 

® To turn off a rule using the Quiet command: 

1 Click the Quiet button in the Correction dialog box or choose Quiet | 

from the Action menu. The Quiet Rule dialog box appears. 

2 If you want to turn off the rule permanently, click the Permanent 
button. 

If you want to turn off the rule for this grammar checking session 
only, click the This Session button. 

Correct Grammar resumes checking your document. 

Turning Off a Grammar Rule Class 

As mentioned earlier in this chapter, Correct Grammar allows you 
to turn off any rule class, except a Core Grammar rule class (only 
individual rules can be turned off in the Core Grammar Rule Class.) 

@ To turn off a rule class: 

1 Press 36-R or pull down the Rules menu and choose Review Style 
Guide. The Grammar Rules dialog box appears. 
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2 Double-click the rule class you want to turn off, or click the rule 
class and then click the Class Off button. The bullet in front of the 
rule class name disappears, indicating that the rule class is turned 
off. 

3 If you want to turn off the rule class permanently, click the 
Permanent button. 

If you want to turn off the rule class for this grammar checking 
session only, click the This Session button. 

Correct Grammar resumes checking your document. 

Turning On a Grammar Rule Class 

@ To turn ona grammar rule class: 

1 Press 36-R or pull down the Rules menu and choose Review Style 
Guide. The Grammar Rules dialog box appears. 

2 Double-click the rule class you want to turn on, or select the rule 

class and then click the Class On button. The rule class becomes 

active and displays a bullet in front of its name. 

Customizing Readability Rules 
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Correct Grammar allows you to customize its review of the readability 
of your writing by modifying the readability rules attached to the cur- 
rent style guide. You can modify these rules by changing the limits for 
the number of words allowed in a split infinitive, the number of con- 
secutive nouns allowed in a phrase, and the number of words and con- 
secutive prepositional phrases allowed in a sentence. You can also set 
the reading grade level of your target audience. Correct Grammar 
checks each sentence to determine whether it exceeds the limits you 
have set. 

For more information on readability, see Appendix B, “The Philoso- 

phy and Methodology of Correct Grammar.” | 
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The Correct Grammar readability rules are in the Readability Rules 
dialog box. 

Split Infinitives ©) All OK 
@ "...to boldly go..." not OK ()"...to rather boldly go..." 

"...to not very boldly go..." © "...toa not at all boldly go..." 

Consecutive Nouns C) All OK 

(3 ",..0ffice automation division..." not OK 

@ "...0ffice automation database division..." 

Cy "...0ffice automation database development division..." 

Prepositional Phrases C4 AL OK 

Cy "...in a ship at the bottom of the sea..." not OK 

(@ "...in the hold of a ship at the bottom of the sea..." 

C)"...in a jarin the hold of a ship at the bottom of the sea..." 

Words in Sentence: Grade Level: 

[ Help || Pere e ht | Pires BeeeQhaey? [cancer | 

® To change a readability rule: 

1 Atthe Rules menu, choose the style guide you want to change. 

2 Press #-R or pull down the Rules menu and choose Review Style 
Guide. The Grammar Rules dialog box appears. 

3 Click the Readability Rules button. The Readability Rules dialog 
box appears. 

4 Click the button for the setting you want in the Split Infinitives, 
Consecutive Nouns, and Prepositional Phrases boxes. 

5 If you want to make the change permanent, click the Permanent 
button. 

If you want to make the change for this grammar checking session 
only, click the This Session button. 
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Split Infinitives 

An infinitive is a verb used with “to,” for example, “to go.” A split 
infinitive has one or more modifiers between the “to” and the verb, for 
example “to clearly see.” Your writing will usually be clearer if you 
avoid using split infinitives. 

The settings for this rule control when Correct Grammar flags the use 
of split infinitives. You can choose only one option for this rule set- 
ting. The examples in the Readability Rules dialog box let you set a 
maximum of one, two, three, four, or more intervening words in a 

split infinitive. The examples indicate the number of intervening 
words that are not to be allowed. 

Click the button for the limit you wish to set; Correct Grammar flags — 
all split infinitives that match or exceed the number of intervening 
words shown in the example. 

Select This Option To Do This 

To boldly go Flag split infinitives with one intervening 
word. 

To rather boldly go Flag split infinitives with two intervening 
| words. 

To not very boldly go Flag split infinitives with three intervening 
words. 

To not at all boldly go Flag split infinitives with four intervening 
words. 

All OK This choice tells Correct Grammar not to 
check for split infinitives. 

Consecutive Nouns 

A noun can act as an adjective modifying another noun. A long 
sequence of nouns usually creates a sentence that is hard to read, for 
example, “pickup truck radiator hose clamp bolt.” Correct Grammar 
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examines each sentence for consecutive nouns and flags those sen- 
tences with consecutive nouns that exceed the preset limit. You can 
change this limit to modify how Correct Grammar flags consecutive 
nouns. 

You can choose only one option for this rule setting. The examples in 
the Readability Rules dialog box let you allow a maximum of 
three, four, or five or more consecutive nouns. The examples indicate 

the number of consecutive nouns that are not to be allowed. 

Click the button for the limit you wish to set; Correct Grammar will 
flag all consecutive noun phrases that match or exceed the number of 
consecutive nouns shown in the example. 

Select This Option To Do This 

Office automation Flag phrases with three or more 
division consecutive nouns. 

Office automation Flag phrases with four or more consecutive 
database division nouns. 

Office automation Flag phrases with five or more consecutive 
database development nouns. 
division 

All OK Allow any number of consecutive nouns. 
This choice tells Correct Grammar not to 

check for consecutive nouns. 

Prepositional Phrases 

A long sequence of prepositional phrases can create an awkward and 
sometimes unreadable sentence, for example, “in the hotel at the north 

side of the park on the west side of town.” Correct Grammar checks 
sentences for prepositional phrases and flags those with consecutive 
prepositional phrases that exceed the preset limit. You can change this 
limit to modify how Correct Grammar checks your documents for con- 
secutive prepositional phrases. 
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You can choose only one option for this rule setting. The examples let 
you allow a maximum of two, three, four, or five or more consecutive 

prepositional phrases. The examples indicate the number of consecu- 
tive prepositional phrases that are not to be allowed. 

Click the button for the limit you wish to set. Correct Grammar will 
flag as violations all consecutive prepositional phrases that match or 
exceed the number of consecutive nse phrases shown in the 
example. 

Select This Option To Do This 

In a ship at the bottom Flag three or more consecutive 
of the sea prepositional phrases. 

Inthe hold ofaship _—s«wF‘lag four or more consecutive 
at the bottom of the sea __ prepositional phrases. 

In a jar in the hold Flag five or more consecutive prepositional 
of a ship at the bottom phrases. 
of the sea 

AllOK | Allow any number of consecutive 
prepositional phrases. This choice tells 
Correct Grammar not to check for 
consecutive prepositional phrases. 

Sentence Length 

Long sentences are usually harder to read than short sentences. 
Correct Grammar counts the number of words in each sentence and 
flags those that exceed the preset limit. You can change this limit to 
modify how Correct Grammar checks your documents for sentence 
length. 

® To set a limit on sentence length: 

7 Atthe Rules menu, choose the style guide you want to change. 



Customizing a Style Guide 

2 Press 38-R or pull down the Rules menu and choose Review Style 

Guide. The Grammar Rules dialog box appears. 

3 Click the Readability Rules button. The Readability Rules dialog 

box appears. 

4 Click the Words in Sentence box. The insertion point appears in 

the box. 

5 Type the maximum number of words you want in each sentence. 

You can set this limit as high as 99, but 32 words per sentence is 

considered best for most writing styles. 

Correct Grammar flags all sentences with word counts that exceed 

the limit. 

6 If you want to make the change permanent, click the Permanent 

button. 

If you want to make the change for this grammar checking session 
only, click the This Session button. 

Grade Level 

When text is written to a certain grade level, it means that adults who 

have completed that grade in school should be able to read and under- 
stand the text. If you specify the grade level of your target audience, 
Correct Grammar will check your sentences to be sure they meet that 

level. You can set grade levels from 1 (first grade) to 16 (college 
eraduate). Any sentence that is too difficult to be read and under- 
stood by readers at that grade level is flagged. 

® To specify a grade level: 

1 Atthe Rules menu, choose the style guide you want to change. 

2 Press 38-R or pull down the Rules menu and choose Review Style 

Guide. The Grammar Rules dialog box appears. 
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Click the Readability Rules button. The Readability Rules dialog 

box appears. 

Click the Grade Level box. The insertion point appears in the box. 

Type the maximum grade level you want Correct Grammar to 

check for. 

To allow sentences of unlimited complexity, set the grade level to 0 

(zero). This setting tells Correct Grammar not to check for grade 

level. 

If you want to make the change permanent, click the Permanent 

button. 

If you want to make the change for this grammar checking session 

only, click the This Session button. 



Appendix A 

Common Grammar 

Problems 

This appendix provides examples of common grammar problems and 
discusses Correct Grammar’s suggested solutions. 

The chairman asked him point blank if the product would ship on 
time. 

Correct Grammar comments that “point blank” is a cliche and sug- 
gests “directly,” “outright,” or “close” as possible substitutes. 

We tried awfully hard to include everyone. 

“Awfully” is a weak modifier, notes Correct Grammar. The 
sentence would be improved by replacing it with “very” or 
“extremely.” 

It is his considered opinion that no more funds should go to that 
facility. 

Correct Grammar explains that “considered opinion” is an over- 
used phrase and recommends being more specific or dropping 
“considered” as a weak or unnecessary modifier. 
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She has included a list of her past achievements. 

The word “past” is unnecessary. Correct Grammar suggests 
deleting it. 

She won the race without hardly running at all. 

“Without hardly” is a double negative. Correct Grammar recom- 
mends that you rephrase the sentence using just “without.” 

They stood waiting with baited breath. 

The correct spelling is “bated” in this context. 

I could care less whether they show up or not. 

Correct Grammar recommends using “couldn’t care less” to convey 
“do not care at all.” 7 

He presented his dossier comprised of letters of recommendation. 

In this sentence “comprised” is misused. Correct Grammar recom- 
mends replacing it with “composed.” 

He took the book which you left behind. 

The use of “which” for a restrictive clause is frowned on by some 
careful writers. Correct Grammar suggests replacing it with “that.” 

We need his feedback on the proposal before the week’s end. 

Correct Grammar identifies “feedback” as jargon and suggests 
“comments,” “response,” or “opinion” as an alternative. 

I met him at the national conference. Sitting at a table in the lobby. 

This is an incomplete sentence. Correct Grammar highlights the sen- 
tence fragment that begins with “Sitting...” and points out that it 
seems incomplete. 
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His appearance as well as his conduct are sloppy. 

The Republican Headquarters are in the downtown area. 

Neither he nor his supervisor want to delay the project. 

The books that win prizes really deserves them. 

There lies several broken parts. 

These examples involve a mismatch between subject and verb. The 
first three require a singular verb and the last two require a plural 
verb. Since Correct Grammar can’t tell what you mean, it some- 
times suggests changing the subject to match the verb. If you ignore 
that suggestion, Correct Grammar suggests changing the verb to 
match the subject. 

Will Bill or him be hired? 

The responsibility rests with she and I. 

It was her who ordered the project cancelled. 

It is common to confuse “he” with “him,” “she” with “her,” and so 

on. Correct Grammar flags these pronoun errors and suggests the 
appropriate form. 

Bob is the candidate whom we think will win. 

“Who” and “whom” are relative pronouns that are frequently mis- 
used. Because contemporary usage has replaced “whom” with 
“who” in many situations, this is an area where Correct Grammar is 
relaxed about the formal rules. 

At our meeting, the chairman turned the task over to me and Bill. 

Correct Grammar points out that the proper form is to place “me” 
at the end of a series. 

The chairman and myself have chosen a new plan. 

“Myself” is a reflexive pronoun and should not be used as the sub- 
ject of a sentence. Correct Grammar suggests that you consider “I.” 
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He asked if it was alright to finish the report later. 

Correct Grammar points out that “all right” is the correct spelling. 

We divided the winnings between the four players. 

Correct Grammar points out that “among” is the form to use when 
more than two are involved. 

Ihave no doubt but that we will meet the deadline. 

Correct Grammar suggests deleting the “but” to resolve the 
multiple negation in the phrase “no doubt but that.” 

It should be a lesson to each and every one of us. 

Correct Grammar points out that “each and every” is unnecessarily 
wordy and recommends replacing the phrase with “each” or 
“every.” 

She acted enthused about her new job. 

Correct Grammar points out that “enthused” is an incorrect word in 
this context and recommends rephrasing the sentence with a form 
of “be enthusiastic” or “rave.” 

He had less men than in the previous campaign. 

“Less” and “fewer” are frequently confused. The correct word to 
use here is “fewer.” 

She tried hard to diligently and courteously offer her assistance. 

“To offer” is the infinitive form of the verb, and putting words 
between “to” and “offer” creates a split infinitive. The Readability 
Rules dialog box lets you adjust the number of words allowed 
between “to” and the verb. 

We had to revise the magazine cover art design specification. 

“Magazine cover art design specification” is called a sequence of 
noun modifiers. You can control the number of noun modifiers 
allowed by Correct Grammar by changing that option in the Reada- 
bility Rules dialog box. 



Common Grammar Problems 

The club provides parking for it’s members. 

“It’s” is a contraction for “it is.” The possessive form needed in this 
sentence is “its,” without the apostrophe. 

Whose responsible for this project? 

This sentence needs the contraction “who’s,” which is short for 

“who is.” “Whose” is the possessive form; it could be used if the sen- 
tence were revised to read “Whose responsibility is this project?” 

The room looked like a tornado had gone through it. 

He organizes people well, like an executive must to be efficient. 

Correct Grammar can spot the misuse of frequently confused words 
such as “like,” “as,” and “as if.” “Like” is a preposition and belongs 
in a prepositional phrase: “He looks like a soldier.” “As” and “as 
if” are conjunctions, and the two examples above require 
conjunctions. 

The workers completed the original building in September, 1952. 

When you use this format (month and year) for a date, no comma is 
required. 

What percent of the stock do they own? 

Correct Grammar points out that “percentage” is used when you 
mean an unspecified amount. 

He wanted a social director with more joy de vivre. 

Correct Grammar examines this and other foreign phrases for 
correct form. In this case, Correct Grammar suggests the correct 
expression “joie de vivre.” 
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Appendix B 

The Philosophy and 
Methodology of Correct 
Grammar 

Why Correct Grammar Works the Way It Does 
by Houghton Mifflin Company 

The CorrecText Grammar Correction System (GCS) builds upon the 
pioneering work in computational linguistics carried out by Dr. Henry 
Kucera and his associates at Brown University. Dr. Kucera and Dr. W. 
Nelson Francis compiled the Brown Corpus of Present-Day American 
English, from which was derived a core word list with statistical 
frequencies. The grammatical analysis required for this work led Dr. 
Kucera to design sophisticated parsing programs that identified the 
basic structural components of English sentences. This technology 
was incorporated into a prototype for CorrecText GCS. Linguists and 
engineers at Houghton Mifflin Company refined the prototype to 
account for the complex sentences common in standard business and 
technical documents and designed rule systems to identify grammati- 
cal and stylistic errors. The final product is the result of a team effort 
that combined computational expertise with a knowledge base 
derived from experience in linguistics, publishing, and language 
pedagogy. 
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Two considerations guided our development of CorrecText GCS. On 

the one hand, the power of the computer technology defines the range 

of problems we can address. On the other hand, the substance and 

style of the product we have developed are determined by our model 

of the linguistic behavior of the real-world user. 

The major technological advance embodied in CorrecText GCS is the 

ability to analyze the structure of English sentences and to identity 

those places in improperly formed sentences where errors of various 

types may have occurred. In addition, the CorrecText GCS software 

incorporates a lexicon containing not only the words likely to be used 

in written documents, but also facts about the way they work in sen- 

tences—regular and irregular inflections, idiomatic constructions, 

frequency of occurrence, capitalization, etc. 

The application of this powerful technology and extensive lexical 

resource to the development of a useful proofreading tool requires 

careful attention to the practical needs of users. We have concentrated 

on the kinds of errors most people make in producing documents such 

as memos, letters, and reports on a word processor. Our goal is to 

make the writing task easier, to inspire confidence that the form of the 

written document will not make a poor impression or interfere with 

the primary goal of communication. We specifically want to avoid 

badgering or intimidating writers with admonishments to fix things 

that don’t seem wrong or with fussy adherence to outdated or exces- 

sively formal styles of expression. The program runs efficiently 

because it does not attempt to locate errors that seldom occur. 

The rules contained in CorrecText GCS’s software derive in part from 

extensive research on effective communications, including business 

communications. They address the errors that people readily recog- 

nize as mistakes once they are pointed out—provoking what we call 

the “Gee, how did I miss that?” response. The grammar and style cor- 

rections correspond to the forms of written expression the user would 

probably have produced if more time for revision had been available. 

Agreement errors within a phrase or between the subject and the verb 

are a common consequence of revising text with a word processor. 

They are often particularly difficult for the writer to spot. For 
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example, CorrecText GCS flags the mistake in the following sentence, 
which could have been caused by partial rewriting: 

The content and structure of the manual reflects the writer's preferences. 

Although CorrecText GCS flags phrases or sentences that deviate from 
conventions for written usage, it is carefully designed so that it inter- 
venes in matters of style and word choice only where appropriate. 
Some products have simply taken phrases from grammar and style 
books and allowed them to be mechanically matched against patterns 
in a document being checked for style. In contrast to such style checkers, 
CorrecText GCS analyzes syntactic form to determine how the words 
are used. Consider, for example, the different ways of correcting 
redundant comparatives like “more better.” One pattern-matching 
system identifies the string “more” followed by any word ending in 
“er” as a possible error. Unfortunately, this has the effect of flagging 
phrases like “more beer,” “more butter,” or “more danger” as redun- 
dant comparatives. At the very least, this sort of overflagging will 
annoy the writer. By referring to parts of speech, CorrecText GCS 
flags only comparative adjectives or adverbs in this construction, 
thereby avoiding overflagging and, in addition, identifying similar 
redundant comparatives like “more worse” and “longer wider” that 
the pattern-matching system would fail to find. 

Pattern-matching systems also have the undesirable effect of confining 
all users to a single level of diction. Decisions about word choice and 
appropriateness of particular locutions should be made by the writer, 
who alone can judge the purpose, audience, and context of the com- 
munication. Insistence upon a particular level of formality or style or 
expression, as embodied in error messages with a prescriptive tone, 
can demoralize the user. Insecurity about writing—apparently a 
major problem even among successful business people—may well 
develop into a full-blown writer’s block when aggravated by conde- 
scending feedback. 

Striving for an excessively formal style too different from the user’s 
ordinary habit of expression can lead to conspicuous grammatical mis- 
takes and result in a document that is less rather than more impressive. 
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We have exercised care and common sense in the selection of errors to 
flag. These include, in addition to agreement problems described 
above, incomplete sentences, comma splice run-ons, colloquial or 
awkward phrases, and common mistakes in pronoun usage, punctua- 
tion, format, and capitalization. Error messages are formulated so as 
to give information about usage and level of diction without imposing 
a narrow conformity. 

We want to help each user produce writing in a comfortable style that 
is at the same time clear, persuasive, and free from what the intended 

audience would identify as genuine errors. 

How Correct Grammar Checks Your Document 
Correct Grammar uses CorrecText GCS to identify and correct errors. 
To do this accurately and quickly, GCS uses a team of four “experts,” 
four computerized specialists that analyze your writing: 

m Sentence Expert 

m Dictionary Expert 

m Parsing Expert 

ma Parse Analyzing Expert 

Each expert processes your writing in its area of competence in 
English. When an expert cannot resolve an ambiguous or complex 
problem, it passes the problem to the other experts, since they have 
access to additional information about the structure of English. 

Sentence Expert 

The Sentence Expert identifies the words, punctuation, and ends of 
each sentence. The Sentence Expert also identifies nonsentences: titles, 
headers, footers, and lists. This is not as simple as it appears. For 
example, a period may indicate the end of a sentence—or an 
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abbreviation. Similarly, a trailing apostrophe may indicate a closing 
single quotation mark—or a possessive plural noun. 

CorrecText checks non-sentences for errors in spelling only, while it 
checks true sentences for errors in spelling, grammar, syntax, punctua- 
tion, style, and format. 

Dictionary Expert 

The Dictionary Expert looks up each word in the Master Lexicon of 
135,000 word forms to determine its grammatical functions and fea- 
tures. This information is needed by the Parsing Expert and Parse 
Analyzing Expert to construct a parse of the sentence, and, mame ek 
to detect and correct errors accurately. 

The Dictionary Expert also must determine the grammatical functions 
and features of words not in the Master Lexicon, especially technical 
terms and jargon, contractions, words in special expressions, and the 
special words you use in your own writing. For example, the Dictio- 
nary Expert determines that she’s can be a contraction for she is or she 
has. It can also determine that the imaginary word dictionarifying 
could be a present participle, adjective, or even a noun. 

The Dictionary Expert identifies spelling errors in various classes: 

a Misspellings that are typographic (doubling a letter: givven instead 
of given) and phonetic (spelling a word as it sounds, such as 
newmonia instead of pneumonia) 

a Grammatical misspellings (using a regular pattern for an irregular 
verb or noun: gived instead of gave or given) 

=” Contraction errors (making complex contractions: she’d’ve instead 
of she would have) 

a Stylistically poor words (using -wise or -ize in jargon words such as 
computer terminal-wise or iconize) 
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= Nonpreferred spellings (using the British variant judgement instead 

of the preferred American variant judgment) 

= Incorrectly used forms (using the form carte outside of the 

expressions carte blanche and a la carte) 

Parsing Expert 
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The Parsing Expert uses efficient and very accurate techniques for 

determining the specific grammatical function of each word in the sen- 

tence. The Parsing Expert uses this information to generate a “parse 

tree.” A parse tree is a formal representation—it looks like an upside 

down tree—of the components of each sentence and how they relate to 

each other. 

The Parsing Expert determines the grammatical functions of the words 

and establishes the relationships between words and punctuation 

marks as they are used in the sentence. To do this, the Parsing Expert 

must find and classify noun and verb phrases, predications (subject- 

verb groups), and a wide variety of coordinate and subordinate 

clauses using information about a range of English syntactic struc- 

tures. Even simple sentences can be difficult to parse because English 

is very ambiguous. For example, this sentence theoretically has 36 

different parses: Time flies like an arrow. 

Time adjective, noun, and verb (3) 

flies noun and verb (2) 

like adjective, adverb, conjunction, noun, preposition, 

and verb (6) 

an article (1) 

arrow noun (1) 

period (1) 
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Parse Analyzing Expert 

The Parse Analyzer examines the parse tree, attempting to identify 
problems in the sentence. Here the Parse Analyzer identifies 
hundreds of errors in five major classes: 

= Core Sentence Grammar Errors 

Incomplete sentences: We off at the last stop instead of We got off at 
the last stop. 

Comma splices: She was a great bicyclist, she rode for miles every 
evening. 

Subject-verb agreement: had gave instead of had given; 

Incorrect pronoun case: Give this to Jenny and I instead of Give this 
to Jenny and me. 

Commonly confused words: its instead of it’s. 

= Context-sensitive Grammar Errors 

Confusing adverbs and adjectives: She hears good instead of She 
hears well. 

Incorrect pronoun order: I and you are good friends instead of You 
and I are good friends. 

m Style Errors 

Colloquial use of verbs as nouns: You should see the quotes I got 
about our film from him! instead of You should see the quotations I got 
about our film from him! 

Colloquial verb forms: We could of gone to the movies instead of We 
could have gone to the movies. 
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# FKormat Errors 

Improper date formats: February 13th instead of February 13 or 13 
February. 

Incorrect punctuation with abbreviations: Turn the handle off 1.e. all 
the way to the left. instead of Turn the handle off, i.e., all the way to the 
left. 

= Punctuation Errors 

Placement of a period inside or outside parentheses: I brought the 
cheese (and she brought the bread.) instead of I brought the cheese (and 
she brought the bread). 

Placement of a comma outside of direct quotations: “You shouldn't 
have done it”, John said. instead of “You shouldn't have done it,” John 

said. 

What Is Readability and How Does Correct 
Grammar Check for It? 
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With Correct Grammar you can communicate more effectively by writ- 
ing at the right level for your audience. It is the only software that lets 
you set target readability values for your text, and then shows you the 
specific sentences where you have exceeded those values. 

The readability factors are grouped together in the Readability Rules 
dialog box. Each of them represents a style consideration that con- 
tributes to the readability of your document. When a sentence exceeds 
any of these values, Correct Grammar notifies you so you can revise it. 

In addition to sentence-by-sentence checking, Correct Grammar gives 
you a report on your document's overall readability. The data and 
indexes are designed to help you gauge your writing level, and can be 
used to compare one document with others, or with earlier drafts of 
the same document. 



The Philosophy and Methodology of Correct Grammar 

The first part of the report tells you about the number of paragraphs, 
sentences, words, and syllables in your document. Each of these— 
length of paragraphs, of sentences, and of words—is a key factor in 
determining the readability of your documents. (Note that Correct 
Grammar does not provide a paragraph count in a few word pro- 
cessing formats.) 

The next item reported is use of the passive voice. Correct Grammar 
helps you avoid a common weak spot in writing—misuse or overuse 
of the passive voice. Here is an example of the passive voice: “The 
committee’s report was read by the president.” It is called passive 
because the subject of the sentence, the report, is not doing anything, 
but rather having something done to it—it is being read. The com- 
munication is much more direct and forceful rewritten in the active 
voice: “The president read the committee’s report.” 

Note that there are times when the passive voice is appropriate. Usu- 
ally this is a situation where the doer is not known or not significant. 
For example, “The notice was posted in the cafeteria.” It is of no impor- 
tance who posted the notice, and introducing that information into the 
sentence might be distracting. You should examine each use of the 
passive voice and ask yourself whether it could be improved by rewrit- 
ing in the active voice. 

Correct Grammar distinguishes between using the passive voice in the 
main clause and in a subordinate clause. In general, the passive voice 
in a subordinate clause is more likely to be acceptable than in the main 
clause. Here is an example of the passive voice in a subordinate 
clause: “George worked all morning on the article, although it had 
already been sent to the printer.” 

The passive voice check can be turned on or off in the Grammar Rules 
dialog box. There are two rules that apply to passive voice. If you 
select Quiet when you see the message This seems to be a passive verb 
construction, you can disable checking of passive voice in subordinate 
clauses. The second rule will still be active, and, when appropriate, 
you will see the message This main clause may be written in the passive 
voice. Be more careful about disabling this rule. 
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The next information reported is the number of long sentences. For 
this entry, a sentence is considered long if it exceeds the “Words in 
Sentence” option in the Readability Rules dialog box. 

The report then categorizes all the problems found in your document. 
First is the number of misspellings that were corrected, and the per- 
centage of correctly spelled words. Next is the number of sentences 
containing non-spelling errors that were corrected, and percentage of 
sentences that were correct. Finally, the hard to read sentences are 
those that exceeded any of the Readability Maximums in the Readabil- 
ity Rules dialog box. As your writing improves, these percentages 
should all get closer to 100. 

The last part of the report consists of several readability scores, using 
the indexes described in the next section. 

Readability Scores 
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Over the years a number of language authorities have tried to estab- 
lish objective standards for evaluating English prose. The underlying 
premise is that, in general, a document communicates most effectively 
if the average sentence is short and direct and uses straightforward 
vocabulary. The best known of these authorities is probably Rudolf 
Flesch, who proposed numerical measures of the readability and inter- 
est level of text. 

The Flesch Reading Ease Score is based on the number of words in 
each sentence, and the average number of syllables per word. On this 
scale, “standard” writing has an average of 17 words per sentence, 
with 147 syllables per 100 words. Writing at this level earns a score of 
about 70 to 80. The highest score, 100, represents the easiest writing 
level, about 4th grade. Scores of 0 to 30 are considered college 
eraduate level. It is worth noting that, even as he created this system 
that evaluates text based on sentence length, Flesch pointed out that 
short sentences can become dull to read; he recommended varying the 
sentence length, striving only to keep the average at about 17 words. 
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The table that follows is Flesch’s summary of reading level for Ameri- 
can adults who have completed the grade level shown.’ 

Description Average Average Reading Estimated 

of style Sentence Number of Ease School Grades 
Length Syllables Score Completed 

per 100 Words 

Very easy 8 or less 123 or less 90-100 4th 

Easy 11 131 80-90 5th 

Fairly easy 14 139 70-80 6th 

Standard 17 147 60-70 7th-8th 

Fairly difficult 21 135 50-60 Some high 

school 

Difficult 25 167 30-50 High school or 

some college 

Very difficult 29+ 192+ 0-30 College 

: Chart from The Art of Readable Writing by Rudolf Flesch. Copyright 1949, 1974 by Rudolf Flesch. 

Reprinted with permission of Harper and Row, Publishers, Inc. 
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Flesch found that, on this scale, Very easy writing could be under- 

stood by 93% of American adults; Easy writing by 91%; Fairly easy 

writing by 88%; Standard writing by 83%; Fairly difficult by 54%; Diffi- 

cult by 33%; and Very difficult by 4 1/2%. These percentage numbers 

are included on the readability report screen. 

The Flesch-Kincaid system attempts to represent readability as a 

school grade level. Writing at the “standard” Flesch level of 70 to 80 

translates to about 7th or 8th grade level writing. The Flesch-Kincaid 

formula has become a standard required by the U.S. Government and 

the military (DOD MIL-M- 387848). 

The Gunning Fog index, developed by Robert Gunning, reports on the 

difficulty of the writing. It considers sentence length but emphasizes 

word length as a measure of “fog level.” Multi-syllable words tend to 

make a document more difficult to read, and thus raise the fog level. 

The Fog index is also given in school grade level, usually higher than 
the Flesch-Kincaid score. 
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Writing Your Own Rules 

Correct Grammar provides all the power that most people need to 

check documents. It is designed to look carefully for writing errors 

without being too obtrusive. Chapter 4 in this manual, “Customizing 

Correct Grammar,” provides instructions for tailoring Correct 

Grammar style guides to the writing style you want. 

This appendix describes another way you can customize Correct 

Grammar: by writing your own Correct Grammar rules. Most users 

never need to write their own rules; however, by doing so, you can 

have more control over the style Correct Grammar will check for. For 

example, your manager may not like to see certain phrases in com- 

pany correspondence; or your company may want to exclude certain 

words and phrases from documents for legal reasons. 

How Rules Work 

A rule tells Correct Grammar to look for a certain word pattern and to 

display error messages and suggestions when it finds that pattern. 

The rules you write may be as simple as finding and flagging an unac- 

ceptable word or as complex as finding and flagging unacceptable 

grammar or style. For example, if you don’t want the word “dweeb” 

used in any of your documents, you can write a rule that tells Correct 

Grammar to look for “dweeb” and propose up to three alternative 

words to replace it. In addition to a message describing the error, you 

can specify a detailed explanation and a tutorial-style lesson. 
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Writing New Rules 
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When you installed Correct Grammar, the program provided 
TeachText and a TeachText file named UserRules that contains sample 
rules you can use as templates for writing simple rules. To write new 
rules, you must write the rules in the UserRules file using TeachText 
or another text editor that produces a plain-text (ASCII) file. 

Writing new rules is a five-step process. Each step of the process is 
explained in detail in the rest of this appendix. 

@ To write a new rule: 

1 Create a rule type. 

Every rule must belong to a rule class. The RULETYPE statement 
creates a rule class. For example, a rule that finds the word 
“dweeb” and suggests alternative words might belong to a rule 
type called FORBIDDEN WORDS. 

2 Createa rule statement. 

The RULE statement defines an individual rule. A rule statement 
can range from finding unacceptable words to looking for 
complicated grammatical constructions. For example, to prohibit 
the use of the word “dweeb” in company correspondence, you can 
write a rule that finds every occurrence of “dweeb” and suggests 
alternative words. 

3 Create error messages and alternatives. 

The Correction dialog box has windows for displaying 
information. The EMn and ALTn statements create messages that 
can appear in these windows. The windows in the upper part of 
the dialog box display suggestions and explanations about the rule. 
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For example, the rule prohibiting the use of the word “dweeb” 
might suggest “Use ‘fool’ instead” in one window and “Don’t use 
this word in company correspondence” in another window. 

The tutorial dialog box appears when you use the Tutorial 
command and provides information about the principle of 
grammar or word usage that applies to the current rule. The 
tutorial dialog box might display the comment “This word is a 
slang word and is not found in the dictionary. Words that are not 
in the dictionary are unacceptable in business writing.” 

4 Compile your rules using the MAKERULES application. 

The MAKERULES application is a program that converts your | 
rules in the UserRules file into code that can be used by Correct 
Grammar. The code is stored in a file called CompiledRules. The 
text in the UserRules file is not changed. 

5 Move the CompiledRules file into the Correct Grammar 
Preferences folder. 

Using MAKERULES to Compile the Rule File 
Once you have written new rules in the UserRules file, you must con- 
vert the information in the file to code that Correct Grammar can use 
to check documents. The MAKERULES application provided with 
Correct Grammar compiles (converts to code) the UserRules file. 

MAKERULES creates a new file named CompiledRules and places the 
code in this file. When checking a document, Correct Grammar first 
uses the rules in the CompiledRules file and then applies its own rules. 

@ To use MAKERULES to compile the UserRules file: 

1 Inthe Correct Grammar folder, double-click the MAKERULES 

application icon. MAKERULES compiles the UserRules file and 
displays a text window. 
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If the rule file compiled successfully, MAKERULES displays the 
message Successful compilation of rule file. This message indicates 
that Correct Grammar has created the CompiledRules file. 

Press Return to quit MAKERULES and return to the Correct 
Grammar folder. | 

Drag the CompiledRules file icon to the Correct Grammar 
Preferences folder. Your new rules are ready to use. 

Note: If you are using any version of System 6.0, the Correct 
Grammar Preferences folder is located in the System folder. If you 
are using System 7.0 or later, the Correct Grammar Preferences 
folder is located in the Preferences folder in the System folder. 

If the rule file did not compile successfully, MAKERULES displays 
an error message and identifies the location of the error. (For more 
information, see “Rule Compiler Error Messages.”) You must 
correct the error and recompile the UserRules file. 

To remedy an unsuccessful compilation: 

Write down the error message and the location of the error. 

Press Return to quit MAKERULES and return to the Correct 
Grammar folder. 

Double-click the UserRules file icon to open it. 

Correct the error identified by MAKERULES and save the file. 

Repeat the steps in the procedure above for using MAKERULES to 
compile the UserRules file. 
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The Rule File 

When you write new rules, you must write them in the UserRules file 
in the Correct Grammar folder. A rule file contains three basic types 
of statements: 

= RULETYPE statements that name new categories of rules in which 
to put new rules 

# RULEstatements that define the actual rules 

=» EMn and ALTn statements that display information about the rule 
and how to comply with it 

Each statement in a rule file begins with a keyword (a word that 
has a special meaning to the MAKERULES compiler.) RULE and 
RULETYPE are the two most important keywords. Several other 
types of statements further describe rules and rule types. The key- 
words for these statements are EM1, EM2, EM3, ALT1, ALT2, and 

ALTS. 

Keywords must always be entered in uppercase. Also, a word that is a 
keyword should be used only as a keyword. Do not use a keyword as 

a rule name. 

You can also use other elements, such as logical operators and 
macros, in your statements to make your rules apply to very specific 
conditions. 

RULETYPE Statements 

The RULETYPE statement format is 

RULETYPE n = name 

where: 

= nisa unique ruletype number from 1 to 100 
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= name is the name of the rule type. The name can be up to 255 
characters long (short names are easiest to use). It can contain any 

characters except these: 

| Lewin boGint MA Cr ios Bnd fet 

or these: 

Space tab linefeed formfeed carriage return 

These characters always end the current field in a statement. 

It’s best to avoid using lowercase letters in a name because the rule 
compiler always interprets that word as a rule type name when it 
appears in a rule. For example, suppose you assign a certain rule 
type the name “wordy.” If the word “wordy” appears in a rule (as 
a word to be avoided, for example), the rule compiler interprets it 
as a reference to a rule type name, even where a rule type name 
isn’t allowed. If you name the rule type WORDY, you don’t have 
this problem. 

The following example shows a RULETYPE statement that defines a 
rule type named FORBIDDEN_WORDS: 

RULETYPE 3 = FORBIDBEN. WORDS 

You can add error messages that Correct Grammar displays when it 
finds a violation of a rule that belongs to this rule type. For more infor- 
mation, see “EMn and ALTn Statements” in this appendix. 

RULE Statements 
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A RULE statement defines a grammar problem and, optionally, tells 
Correct Grammar what to do when it finds that problem. 

Every rule must belong to a defined rule type. Therefore every RULE 
statement must refer to a preceding RULETYPE statement. 
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The RULE statement format is 

RULE \pattern ruletype n 

where 

a The \ (backslash) indicates that the following word is a trigger 
word. Every rule pattern must contain exactly one trigger word. 
For more information, see “Trigger Words” later in this appendix. 

= the word pattern specifies the word pattern (usually a word or a 
phrase) that the rule is to detect. 

= the word ruletype identifies the rule type to which this rule belongs. 

m™ the7 is a unique rule number from 1 to 255. 

Here’s an example of a RULE statement that refers to the rule type 
FORBIDDEN_WORDS: 

RULE \dweeb FORBIDDEN WORDS 1 

A RULE statement can span any number of lines. This is important 
because the RULE statement is the only type of statement that has 
several parts. For example, the statement above can also be written 
like this: 

RULE 

\dweeb 

FORBIDDEN WORDS 
1 

In the following sections you'll encounter several RULE statements 
that are so long they must be divided into several lines. 

EMn and ALTn Statements 

You can use two kinds of statements, EMn, and ALTn, to specify the 

text you want to appear on the screen when a rule is violated. Each of 
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these statements must appear immediately after a RULE or 
RULETYPE statement. 

If an EMn or ALTn statement appears 

ms Aftera RULE statement, it affects the rule defined by that RULE 
statement. 

m Aftera RULETYPE statement, it affects the rules defined by all 
RULE statements that belong to that rule type and don’t have their 
own EMn or ALTn statements. 

= After a RULE statement and the associated RULETYPE statement, 

an EMn or ALTn statement in the RULETYPE overrides the one in 

the rule. 

The EMn Statement 

The EMn statement defines an error message for a rule or rule type. 
When Correct Grammar encounters a violation of the affected rule, it 

displays the message in the explanation window. The EMn statement 
format is 

EMn = “Error Message” 

The n can be 1, 2, or 3, and you can use any or all of the EM statements 
to define several kinds of error iene 

=u EM] defines a message that appears in the top window of the 
Correction dialog box. It can be up to 80 characters long. 

= EM2 defines a message that appears in the lower part of the 
explanation window. It can be up to 240 characters long. 

= EMS defines a message that appears as the tutorial text if the user 
requests it. It can be up to 10,000 characters long. 

In each case, a line break counts as 2 characters. 
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Here’s an example of a rule with the two types of error messages: 

RULETYPE 3 = FORBIDDEN_WORDS 

RULE \dweeb FORBIDDEN_WORDS 1 
EM1 = “Consider dope instead.” 
EM2 = “Everybody dislikes this word, and it’s 

not in the dictionary anyway.” 

Notice that the text in EM2 occupies two lines. Correct Grammar 
inserts appropriate line breaks when it displays the text. (For more 
information about displaying line breaks, see “Escape Sequences in 
Error Messages” in this appendix.) 

You can divide EMn text into any number of lines, as long as it begins 
and ends with quotation marks. When you compile the rule file, it is 
treated like this: 

= Leading and trailing spaces on each line are ignored. 

= Each line break is treated as a double space if the last character on 
the preceding line is a period, and a single space if it is not. 

Avoid ending a line with a period that represents an abbreviation, 
because the rule compiler will think it represents the end of a 
sentence and insert two spaces after it. 

The ALTn Statement 

The ALTn statement defines an alternative to a word or phrase that 
violates a rule. The 1 can be 1, 2, or 3, and you can define up to three 

different alternatives for Correct Grammar to propose when a rule is 
violated. You then use ALTn in an EM1 statement to include the alter- 
native in that statement. All alternatives (ALTn) must displayed in the 
EM1 statement. The ALTn statement format is 

ALTn = “Alternative” 

The EM1 and ALTn statements can be in any order, as long as they 
all immediately follow the RULE or RULETYPE statement they’re 
associated with. 
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The following example shows a rule with one alternative (ALT1): 

RULE \Acme FORBIDDEN_WORDS 2 
EM1 = “Consider ALT1 instead.” 

EM2 = “Don’t name our competitors in published 
documents.” 

ALT1 = “one midwestern manufacturer” 

The EM1 message would look like this when displayed: 

Consider ’one midwestern manufacturer’ instead. 

Note that Correct Grammar puts apostrophes around the alternative 
that it substitutes into the message. 

The following example shows a rule that proposes two alternatives to 
a forbidden word: 

RULE \nerd FORBIDDEN WORDS 3 

EMT «.=.“Consider ALLL: or: ALT2 bnsttead. = 

EM2 = “Everybody dislikes this word, and it’s 

not in the dictionary anyway.” 

ALTI = “dope” 
ALT2 = “fool” 

Comments 
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Any line in a rule file that begins with a pound sign (#) is a comment. 
Comments document the contents of a rule file; they have no effect on 
the operation of Correct Grammar. They can appear before, between, 
or after the statements, but not within a statement. 

Blank lines can appear anywhere in a rule file, that is, before, between, 

after, or within statements. 

A pair of statements separated by some comments and a blank line 
might look like this: 
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RULETYPE 3 = FORBIDDEN_WORDS 

EM1 = “The boss hates this word.” 

# A line that starts with a pound sign is a comment. 
## EM1 stands for error message, level l. 

#t (Any number of statements and blank lines can 
## separate the rule from its parent rule type, but 
# the RULETYPE statement must be first.) 

RULE \dweeb FORBIDDEN WORDS 1 
EM1 = “Consider ALT1 instead.” 

EM2 = “Everybody dislikes this word.” 

ALT] = “dope” 

Escape Sequences in Error Messages | 

Certain sequences of characters have special meanings in error mes- 
sages. They’re called escape sequences because they let you escape 
from the convention that every character in the message represents 
itself. Escape sequences let you format error messages and use charac- 
ters that you otherwise could not express. 

Here’s an example of an error message that contains an escape 
sequence: 

EM2 = “Don’t name our competitors in published 

documents.\P\PIf you must identify a 

competitor; do so py describing: Tts product.” 

The escape sequence \P\P represents two line breaks, or a new para- 
graph. The message is displayed like this: 

Don’t name our competitors in published documents. 

If you must identify a competitor, do so by describing its 

product. 

The escape sequences you can use are listed below. Note that case is 
significant; \P is a valid escape sequence, but \p is not. 
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Line break (use two to represent a new paragraph) 

Matches s when Correct Grammar is checking British spelling and z 
when it’s checking American spelling. Useful in words that are spelled 
differently in British and American English 

The character \ 

The character “ 

More Complex Rules 
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So far you’ve seen only the simplest type of rule, that is, one that looks 
for a single word or a fixed sequence of words. You can also define 
more sophisticated rules that manipulate any unit of text up to a 
complete sentence. The following sections explain how. 

Trigger Words 

A trigger word is a word whose presence in text triggers the applica- 
tion of arule. It is preceded by a backslash (\). Every rule pattern 
must contain exactly one trigger word. 

For example, in the first rule below, “again” is the trigger word. In the 
second rule, “course” is the trigger word. In the third rule, “owing” is 
the trigger word. 

RULETYPE 4.= WORDY 
RULE \again and again WORDY 1 

ALT1 = “repeated| y” 
EM1 = “Wordy expression. Consider ALT1 instead.” 

RULE in the \course of WORDY 2 

ALTI = “during” : 

EM1 = “Wordy. Try using ALT1 or rewriting the 

sentence with ’while’." 
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RULE \owing to the fact that WORDY 3 

ALTls =.“because” EN 
EM1 = “Wordy expression. Consider ALT1 instead.” 

When Correct Grammar finds a trigger word, it checks the associated 
rule to see if it fits the text; that checking process is less efficient than 
the process of finding trigger words. Selecting the least frequently 
used word in a rule definition as the rule’s trigger word increases the 
speed and efficiency of the search. 

A trigger word must be an invariant part of a rule definition; that is, it 
must always appear in the same position in text that matches the rule. 
It cannot be a macro (such as IS PRONOUN, which matches any pro- 

noun) or an optional word. If it appears in a logical expression it must 
appear in the first part of the expression. For more information, see 
“Logical Expressions,” “Optional Parts,” and “Macros” in this 
appendix. 

Optional Parts 

You can use braces ({ }) to identify an optional part of a rule pattern, as 
in this example: 

RULE a matter of {public} \record WORDY 4 

ALT1 = “documented” 

ALT2 = “on the record” 
EM1 “Wordy expression. Consider ALT1 or ALT2 

instead.” 

I 

The word “public” may or may not occur in the expression. Thus this 
rule will flag both the expressions “a matter of record” and “a matter 
of public record.” 

Any Inflection of a Word 

An asterisk (*) after a word indicates “any inflection of the word.” For 
example, adding an asterisk after the word “crash” in the following 
rule will flag inflections like “crashes,” “crashed,” and “crashing” as 
well as “crash.” 
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RULE: \crash*....FORBIDDEN WORDS 3 
AES Corie ion | 
ALT2 = “casualty” 

ALT3 = “incident” 

EMI. .=.*Censider, ALdd;2ALI2,--or- ALA 3. stead,’ 

EM2 = “Avoid using words with strong negative 

Conmmrote ti ons.” 

A Contraction of a Word 

Whenever Correct Grammar encounters a contraction such as 

“doesn’t” or “they’re,” it expands the contraction before matching the 
text to rules. Thus any rule that matches a phrase that can be con- 
tracted matches the contraction as well. For example, the following 
rule will flag the phrase “doesn’t hardly” as well as “does not hardly.” 

RULETYPE 5 = NEGATIVES 

RULE \does not hardly NEGATIVES 1 

EM1 = “This is a double negative.” 

Macros 

The behavior of a word can vary with its use in a sentence. You can 
use macros in rules to allow for this behavior. A macro matches 
words only when they’re used in the specified way. 

For example, the macro IS_FORM_OF_BE matches all inflections of 

the verb “to be.” Thus it matches “be,” “is,” “are,” “was,” “were,” 

“being,” and so on. But “being” can also be used as a noun, as “He is 
a being from another planet.” When “being” is used in this way, it 
isn’t an inflection of “to be,” and IS FORM_OF _BE doesn’t match it. 

Macros with the prefix CAN_ determine whether the current word can 
be a certain kind of word, no matter how it is used in the current sen- 

tence. An example is CAN_BE_ORDINAL, which matches any word 
that can be an ordinal number, like “second.” Macros with the prefix 
IS_ determine whether the current word is the kind of word in ques- 
tion in the current sentence. An example is IS_ORDINAL, which only 

matches a word that is an ordinal number in the current sentence. 
IS ORDINAL would match “second” in “I fixed the second problem,” 
but not in “It only lasted a second.” 
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Most macros have both a short and a long name. For example, the 
short name of IS ORDINAL is IS ORD. You can use either name for a 

macro. 

This rule contains an optional macro that can match a noun phrase of 
any length: | 

RULE take* {IS NOUN PHRASE} into \consideration WORDY 5 

EM1 = “Wordy expression. Simplify by using the 

verb consider’ .” 

The macro IS NOUN_PHRASE can match a noun phrase containing 
any number of words. Thus the rule will flag “take into considera- 
tion,” and also expressions like “take your advice into consideration” 
and “take the profit of the company into consideration.” 

You can use macros to restrict the cases that a rule pattern will match. 
For example, this rule matches an inflection of the word “author” only 
when used as a verb: 

RULETYPE 6 = WORD CHOICE 

RULE \author* 8° ES VERB WORD CHOICE 1 

EMi- = “Gonsider-a forme: AkTL-unlesse this 3S. a 

be chica: terms: ~ 

ALT1 = “write” 

Macros are also useful when you want to flag a word or phrase only if 
some grammatical construction occurs in it or near it. The next rule is 
an example; it only matches “afford” followed by a noun phrase. The 
noun phrase could be a simple noun or pronoun, like “the worker” or 
“him,” or it could be more complicated, like “the boy and girl on the 
beach.” 

RULE \afford* IS_NOUN_PHRASE (the|an) opportunity WORDY 6 

EM1 = “Wordy. Use the verb ALT1 or ALT2 and omit 

“(Terai ODDO LURITULY~. * 
ALT1 = “permit” 

Moh 2 “allow” I 

The section “Macros and Their Functions” lists all the macros and 

describes the construction that each macro will match. 
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Logical Expressions 

You can use logical expressions to flag phrases that do or do not con- 

tain combinations of words or alternative words. A logical expression 

uses the and (&), or (1), or not (!) operators to determine whether text 

matches the rule. 

The following rule statement uses a logical expression containing the 

or operator (|) to flag either of the expressions “at a later date” or “at a 

later time.” 

RULE at a \later date|time WORDY / 

The following rule statement uses the logical and operator (&) to flag 

any use of the word “swell” as an adjective. (IS_LADJECTIVE is a 

macro, that matches any word or phrase used in a specified way; in 

this case, as an adjective.) 

RULE \swell & IS_ADJECTIVE WORD_CHOICE 2 

The following rule statement uses the logical not operator (!) to flag 

any use of the word “meantime” that is not preceded by “the”. 

RIGEE Ithe \meantime WORD CHOICE 3 

When you use different logical operators in a single rule, 

MAKERULES applies them in this order when it compiles the rule: 

= Not (!) operators 

= And (&) operators; consecutive and operators from left to right 

= Or (|) operators; consecutive or operators from left to right 

= Concatenation, implied by two words with no operator between 

them. 
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For example, the following rule statement is evaluated in the order 
shown below. 

RUE “Gutstde 6 elo NOUNS |) TastTue &- FIS=NCUN A OT” WORDY 8 

a Apply the! operator to the first instance of IS_NOUN, then to the 
second. 

a Evaluate the expression “outside & !'IS5_NOUN”, and then the 

expression “inside & !IS_NOUN”. 

= Combine the two expressions with the | operator. 

= Concatenate the expression “outside & !IS_NOUN | inside & 
'IS_NOUN” with the trigger word “\of.” 

Thus the rule will match any occurrence of either phrase “outside of” 
or “inside of” in which “outside” or “inside” was not a noun. 

If you want to change the order of evaluation, you can use parentheses 
to enclose the part of an expression to be evaluated first. For example, 
the & operator normally takes precedence over |. So, in the first of the 
following two rule statements, “inside & !is_noun” is evaluated first, 

and the result is combined with “outside.” Thus it matches “inside of” 
if “inside” is used as a noun, but it matches “outside of” whether or 

not “outside” is used as a noun—probably not the intended meaning. 
The second rule statement uses parentheses to force MAKERULES to 
evaluate the | before the &. 

RULE ‘outside }inside ITS NOUN: \of © WORDY- 9 
RULE? Comt sa de} aarst de?) ert DS NOUNS Ao aWORDY =. 9 

You can use parentheses for clarity even when you don’t need to 
change the order of evaluation. The following rule statement is equiv- 
alent to the second one in the preceding example, but is easier to read: 

RULE (Coutside|inside) & !IS_NOUN) \of WORDY 9 
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Multiple Operators in the Same Rule 

You can use any combination and any reasonable number of operators 

in the same rule. For example, you can use several asterisks and 

logical operators. You can use several pairs of parentheses, either in 

sequence or nested like this: 

L EXXKe 8 Cyyy | ZZZ )) 

Here are some examples: 

RULETYPE 7 = REDUNDANT 
4 Several ‘words ' fol lowed ‘by’ asterisks’. 

RULE \completely (demolish*|destroy*|eliminate*) REDUNDANT 1 

EM1 = “Redundant expression. Consider deleting 

“completely ’.” 

## Two optional parts, one containing an ’or’ operator. 

RULE at {the} \present {moment|time} WORDY 10 

ALT2 -= “row” 
ALT2 = “today” 

EM1. = “Wordy expression. Consider ALT1 or ALT2 

instead.” 

## The expression “be (clearly, etc.) an indication of.” 

RULE be* {IS _ADVERBIAL} an \indication of  WORDY 11 

ALT1 = “indicate” 

ALT2 = “show” 

EMI “Wordy expression. Consider ALTI or ALT2 instead.” 

The last rule shows the use of the IS ADVERBIAL macro as an 

optional component of a rule. IS_ADVERBIAL matches many con- 

secutive adverbial words, including the word “not”. Thus the rule 

will flag expressions like “is an indication of,” “was not an indication 

of,” and “are not always an indication of.” 

Rule Scope 

When Correct Grammar flags a problem in a document, it normally 

highlights everything that matches the rule. You can limit the 

highlighting to the text matching part of the rule by enclosing that part 

of the rule in brackets. The brackets limit the scope of the rule. 
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Here’s an example that shows a rule with limited scope: 

RULE \appears [Las though] WORDY 12 

ALT1 = “that” 
EM1 = “Wordy expression. Consider ALT1 instead.” 

When this rule causes text to be flagged, only the words “as though” 

are highlighted. If the user asks Correct Grammar to make the change, 

only the words “as though” are replaced with “that.” 

The following rule shows how several features of the rule—writing 

language can be combined to create a useful rule. The rule flags forms 

of the verb “leave” that are followed by a noun phrase, then the infini- 

tive form of a verb. Optional adverbial words may appear between 

the noun phrase and the infinitive. When the rule is violated, only the 

word “leave” is flagged. 

RULETYPE 8 = NONSTANDARD 

RULE [\leave* & IS VERB] IS NOUN PHRASE {IS_ADVERBIAL} 

TS INFINITIVE NONSTANDARD 1 

ALT1 = “let” 
EM1 “horstancaara 1 cons laer ALT. “IiSteau. ~ 

This rule can flag expressions in sentences like these: 

Leave him go. 

Leave us not quarrel over this. 

I’m used to people leaving me finish their sentences for them. 

Spelling Errors in Matched Text 

When a rule matches text, Correct Grammar may suppress a spelling 

error that would normally be generated for a word not found in the 

dictionary. This happens if the misspelled word was the rule's trigger 

word. 

If you write a rule that has a deviant spelling for the trigger word, 

Correct Grammar assumes that the rule is supposed to generate an 

error message for any occurrence of that spelling. It suppresses the 

generic spelling error that it normally generates. 
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For example, suppose you write a rule to flag the erroneous word 
“ourself”: 

RULETYPE 9 = NONWORD 

RULE \ourself NONWORD sl 

EM1 = “Consider the word ’ourselves’.” 

Normally Correct Grammar would generate an error message saying 
that “ourself” was not found in the dictionary. This message is 
suppressed, however, when a rule with “ourself” as the trigger word 
is invoked. 

Operators 
An operator is a character or group of characters that has special mean- 
ing ina MAKERULES command. It’s analogous to punctuation in 
English text. 

The following table describes the operators recognized by 
MAKERULES and their meanings. The preceding sections of this 
appendix explain them and give examples of their use. 

= noid ot Used in RULETYPE, RULE, ALTn, and EMn statements. 

Defines text strings in ALTn and EMn statements. 
Note: An empty string, ” ”, is valid. 

ee ee ee 
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resents a forced end of line in an error message. Valid only in EMS. 

resents a tab in an error message. Valid only in EM3. 

resents a literal \ in an error message. 

resents a literal “ in an error message. 

Macros and Their Functions 

The following table describes the macros that MAKERULES 
recognizes. 

CAN_BE CARDINAL 

CAN_BE_CD 

Tests for a possible cardinal number, such as 
one, two, or three. 

CAN_BE_ORDINAL 

CAN_BE_OD 

Tests for a possible ordinal number, such as 
first, second, or third. 

CAN_BE PAST _PARTICIPLE 
CAN_BE_ PA PART 

Tests for a possible past participle, such as eaten, 
shown, taken, or moved. 
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CAN BE PRESENT PARTICIPLE Tests for a possible present participle, such as 

CAN BE PR PART eating, showing, or taking. 

CAN _ BE_VBI Tests for a possible infinitive form of a verb, 

such as be (which is always a verb) or show 
(which could be a noun or adjective instead). 

IS_ADJECTIVE Matches a simple, comparative, or superlative 
IS_ADJ , adjective, such as green, big, enthusiastic, quick, 

quicker, or quickest. Also matches a past 
participle of a verb functioning as an adjective. 

IS_ADVERB Matches a simple, comparative, or superlative 
IS _ ADV adverb, such as slow, slower, slowest, fast, faster, 

or fastest. 

IS ADVERBIAL Matches an adverb (like IS ADVERB). Also 

IS ADVBL matches the word not, and any number of 

consecutive adverbs and instances of not. 

Note: IS_ADVERBIAL is more appropriate than 
IS_ ADVERB in most rules. The word not often 

occurs with adverbs, and should usually be 
treated as an adverb. Also, since adverbs often 

occur consecutively, this macro lets you specify 
adverbial words in a certain position in a rule 
without having to specify an exact number of 
them. : 

Matches definite and indefinite articles, such as 

a, an, or the. 
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IS_AUXILIARY 
IS_AUX 

IS_BEGIN_CLAUSE 
IS_BEG CL 

IS_BEGIN_NOUN_PHRASE 
IS_BEG_NPHR 

IS_CARDINAL 
IS_CD 

IS_COMPARATIVE 
IS_CMPR 

IS_LEND_CLAUSE 
IS_END_CL 

IS_END_NOUN_PHRASE 
IS_END_NPHR 
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Matches auxiliary verbs that aren’t forms of the 
verb to be, such as forms of the verbs to do and to 

have and the modal auxiliaries, such as can, may, 

and will. 

Matches the current word if it occurs at the 

beginning of a sentence clause. Sentence 
clauses include main clauses, coordinate 

clauses, relative clauses, and other subordinate 

clauses. 

Matches the current word if it’s the first word in 

a noun phrase. 

Matches a cardinal number such as one, two, or 

three. 

Matches a comparative adverb or adjective such 
as bigger, faster, or calmer. 

Matches the current word if it is at the end of a 

sentence clause. Sentence clauses include main 

clauses, coordinate clauses, relative clauses, and 

other subordinate clauses. 

Matches the current word if it is at the end of a 
noun phrase. The last word in a noun phrase is 
usually the head noun of the phrase, that is, the 
word involved in subject-verb agreement and 
other types of concord. 
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IS FORM _OF BE Matches all forms of the verb to be: 

IS_BE 
am First person singular present tense. 
is Third person singular present tense. 
are Third person plural and second person 

singular and plural present tense. 
was First and third person past tense. 
were Other past tense forms. 
be Infinitive. 
being Present participle. 
been _ Past participle. 

Also matches contracted forms of be such as 

they're and isn’t. 

Matches all forms of the verb to do: IS_ FORM_OF_DO 
IS_DO 

does _ Third person singular present tense; 
not the noun does (female deer). 

do Other present tense forms and infinitive 
form. 

did Past tense. 
doing Present participle. 
done Past participle. 

Also matches contractions such as don’t. 

IS FORM _OF HAVE Matches all forms of the verb to have: 

IS_HAVE 
has Third person present tense. 
have Other present tense forms and infinitive. 
had Past tense and past participle. 
having Present participle. 

Also matches contractions such as hasn't. 
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IS_INFINITIVE 

IS_INF 

Matches any infinitive form of a verb. 

Note: A verb that follows the infinitive marker 

to is usually an infinitive (to think, to want, to 

claim); so is a verb that follows a modal 

auxiliary (can think, might want, dare claim). 
Infinitives may occur in other places in a 
sentence. 

Matches a word written with an initial 
uppercase letter, such as Boston, or America. 

IS_INITIAL_UPPERCASE 

IS_INIT_UC 

IS_IN_PREDICATE 
IS_IN_PRED 

Matches the current word if it’s in the predicate 
of a clause. For example, matches soon in the 

sentence “The green alien will soon vanish,” 
because soon is in the predicate will soon vanish. 

IS_IN_SUBJECT 
IS_IN_SUBJ 

Matches the current word if it’s in the subject of 
a clause. For example, matches green in the 
sentence “The green alien will soon vanish,” 
because green is part of the subject the green alien. 

IS_LOWERCASE 

1S_LC 

Matches a word written entirely in lowercase 
letters. 

Matches a word written with some internal 

uppercase letters, such as tRNA or CorrecText. 
IS_MIXED_CASE 

Matches any modal auxiliary verb: can, could, 
dare, may, might, must, need, ought, shall, should, 

will, or would. 

IS_MODAL 

Matches any word used as a noun, whether 
singular or plural, common or proper. 
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IS_NPHR 

IS_OBJECT_PRONOUN 
IS_OBJ_PRO 

IS_ORDINAL 
IS_OD 

IS_ PAST _PARTICIPLE 

IS_PA_PART 

IS_PLURAL_NOUN 
IS_PL_NOUN 

IS_POSSESSIVE 
IS_POS 
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Matches both simple noun phrases (as does 
IS_SIMPLE_NOUN_PHRASE) and complex 
noun phrases. Some complex noun phrases are 
the dog and cat, my friends and relatives at the 
beach, and my brother, the doctor. 

Matches a word that is an object pronoun such 
as me, her, us, them, or who. Since the macro 

uses database information, object pronouns 
mistakenly used as subjects will match, as in 
“The boys and me watched the game.” 

Matches an ordinal number such as first, second, 

or third. 

Matches any past participle verb, including 
been, done, gone, had, or taken. 

Past participles occur after forms of the 
auxiliary verb have (for perfect aspect), as in the 
phrases has taken and will have gone, and after 
the auxiliary verb be (for passive mode), as in 
the phrases was taken and will be broken. 

Note: Most verbs have the same form for the 
simple past tense and the past participle. 

Matches any plural noun, proper or common. 
Also matches a noun whose plural and singular 
forms are the same, such as fish or sheep. 

Matches possessive forms, such as the 
adjectives my, your, our, and whose, and 
possessive nouns such as boy’s, office’s, and 
islands’. 



IS_PREDICATE 
IS_PRED 

IS_PREPOSITION 
IS_PREP 

IS_PREPOSITIONAL_PHRASE 
IS_PREP_PHR 

IS_PRESENT_PARTICIPLE 
IS_PR_PART 

IS_PRONOUN 
IS_PRO 

IS_REFLEXIVE_PRONOUN 
IS_REFL_PRO 

IS_RELATIVE_CLAUSE 
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Matches the entire predicate of a clause. For 
example, matches will soon vanish in the 

sentence “The green alien will soon vanish.” 

Matches prepositions, such as of, in, with, over, 

and against. Also matches prepositions acting 
as verb particles (keep up). Does not match 
verbal particles that can’t be prepositions (keep 
back, keep away). 

Matches prepositional phrases, consisting of a 
preposition followed by a noun phrase, such as 
to the beach or with our new friends. Also matches 
a series of consecutive prepositional phrases, 
such as in the cabin on the path by the sea. 

Matches a present participle verb form, such as 

eating, showing, or taking. 

Matches any type of pronoun, such as 
a nominative pronoun such as I, she, or we 

an objective pronoun such as me, her, or us 
a relative pronoun such as who or whom 
an indefinite pronoun such as anybody, 
everyone, or somebody 

a possessive pronoun that can act like a 
noun, such as mine, yours, or theirs 

Matches a reflexive pronoun, singular or plural, 
such as myself, yourself, ourselves, or themselves. 

Matches a relative clause that modifies a noun, 

such as “The dog that I saw was black.” 
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IS SIMPLE_NOUN_PHRASE 

IS_SIM_NPHR 

Matches a simple noun phrase, consisting of a 
noun and modifiers such as articles and 
adjectives. Some examples of simple noun 
phrases are the big doghouse, my favorite foods, 
and several blue and white cars. 

IS_SIMPLE_ PAST 
IS_SIM_PAST 

Matches any simple past tense verb, such as ate, 
did, took, was, or moved (but not eaten, done, taken, 

or been, which are past participles rather than 
past tense verbs). 

Note: Most verbs have the same form for the 
simple past tense and the past participle. 

IS_SINGULAR_NOUN 
IS_SG_NOUN 

Matches any singular noun, proper or common. 

IS_SUBJECT Matches the entire subject of a clause. For 
example, matches the green alien in the sentence 
“The green alien will soon vanish.” 

IS SUBJECT PRONOUN 
IS SUBJ_PRO 

Matches the current word if it’s a subject 
pronoun such as I, she, we, they, or who. Since 

the macro uses database information, it will 

match subject pronouns mistakenly used as 
objects, as in “Our supervisor took the boys and 
I to the game.” 

IS_ SUPERLATIVE 
IS_SUPRL 

Matches superlative adverbs and adjectives, 
such as biggest, fastest, smartest, soonest, and 

calmest. 

IS_UPPERCASE 
ele 

Matches a word entirely in uppercase letters, 
such as NASA. 

IS_VERB Matches any word used as a verb. Matches 
both main verbs (go, read, compute) and auxiliary 
verbs (may go, should read, will compute). 
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Rule Compiler Error Messages 
When you run the MAKERULES rule compiler, it displays the mes- 
sage Successful compilation of rule file if it finds no errors. If 
MAKERULES finds any errors, it displays messages describing them. 
This section lists the error messages and describes how to correct the 
errors. 

Miscellaneous Error Messages 

Because macros and literal words often occur in the same positions in 
a rule, MAKERULES can’t always be sure whether a word is supposed 
to be a macro or a literal word. It expects any word that contains an 
underscore (_ ) to be a macro. If it encounters a word containing an 
underscore that is not a recognizable macro, it treats it as a literal word 
but issues a warning message. 

For example, if you inadvertently write IS_VERBB instead of IS_VERB, 
MAKERULES displays a message like this: 

WARNING: A macro was possibly misspelled on line 3, column 16. 

(TSOVERBE?) 
SUCGESSEU -GOMPT bA LION OF” Ribkit> «Fd toE 

If your rule file contains no rules, MAKERULES displays the message: 

NO. RULES sFOUND IN INPUT ELLE. 

Syntax Errors 

Other messages displayed by MAKERULES indicate various kinds of 
syntax errors in the rule file. When MAKERULES encounters a syntax 
error, it displays a message and stops compiling; it produces no com- 
piled rule file and does not try to check the rule file for additional 
errors. 
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Each syntax error message consists of 

a Anerror number 

a ‘The location of the error, as precisely as MAKERULES can identify 
it; for example: 

A syntax error was detected on or before line 2l, 

character 8. 

a A description of the type of error detected 

For example, if MAKERULES detects an illegal use of a token (a word 
or punctuation mark) in the rule file, it displays a message like this: 

RULES COMPILER SYNTAX ERROR NUMBER: I 
A syntax error was detected on or before line 56, character 31. 

An illegal token was detected. The token is probably out of 

piace. Check for a missing or incorrect token at or before 

the token: = 

The error messages MAKERULES can issue are described below: 

Error 1 

An illegal token was detected. The token is probably out of place. 

Check for a missing or incorrect token at or before the token: xxx. 

The rule file doesn’t conform to the format described in this Appendix. 
For example, you may have omitted the rule number after a rule type 
identifier. 

Error 2 

The end of file was encountered before a matching double quote 
was found. 

Check for a missing or incorrect token at or before the token: xxx. 

You started text in a statement with a quotation mark but failed to end 
it with a second one. (Or you ended a statement with a quotation 
mark and left off the opening quotation mark.) Insert the quotation 
mark in the appropriate place. : 
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Error 3 

No trigger word was specified for this rule. 

You defined a rule pattern without a trigger word, identified by a pre- 
ceding backslash (\). 3 

Error 4 

You cannot specify more than one highlighted region per rule. 

You defined a rule pattern with more than one highlighted area 
enclosed in square brackets ([ ]). Remove all but one pair of brackets. 

Error 5 

Only one trigger word can be specified per rule. 

You defined a rule pattern with more than one trigger word identified 
by a preceding backslash. Remove all but one backslash. 

Error 6 

The trigger word must be specified first in a rule component. 

When you specify a trigger word in a compound rule pattern, it must 
be in the first component of the pattern. A component of a rule pat- 
tern is any part joined to another part by a logical and (&) or a logical 
or (|). For example, MAKERULES issues this message if you define a 
rule that contains the expression IS_NOUN & \time rather than \time 
& IS_NOUN. 

Error 7 

A trigger word cannot be in an optional component of the rule. 

You defined a rule in which the trigger word appears in an optional 
part of the rule pattern, identified by braces ({ }). For example, you 
can’t specify a rule pattern that contains an expression like {\time & 
IS_NOUN}. , 

Choose another word as the trigger word or remove the braces that 
identify the word as optional. 
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Error 8 

The backslash must immediately precede the trigger word. 

You put a space or a tab between a trigger word and the preceding 
backslash. Delete the space or tab. 

Error 9 

You cannot use a logical NOT (!) with a trigger word. 

You applied the logical not operator (!) to a trigger word. Rewrite the 
rule to eliminate the error. 

Error 10 

Not applicable. 

Error 117 

The closing double quote must be on the same line as the opening 
double quote. Only error message fields can span more than one 
line. 

Only error message fields can span more than one line. Shorten the 
statement to span one line only. 

Error 12 

Backslashes within double quotes can only be followed by P, T, or 
L, another backslash, or a double quote. 

A backslash within double quotes begins an escape sequence and can 
be followed only by a P, T, or L, another backslash, or a double quote. 

Eliminate the invalid backslash or turn it into a valid escape sequence. 
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Error 13 

The error message is too long or it is missing its closing double 
quote. The size limits for error messages are 80 characters for level 
1, 240 for level 2, and 10000 for level 3. 

You have written an error message that exceeds the lengths specified 
in the message level. You may shorten the error message or increase 
its level number. For example, if a level 2 (EM2) error message is too 
long, you may change it to a level 3 (EM3) message. 

Error 14 

The token is too long—it exceeds 256 characters. 

A token ina rule pattern can’t be more than 256 characters long. 
Shorten the token that caused the error. 

Error 15 

An invalid error level number was found—it must be either 1, 2, or 3. 

Check for a missing or incorrect token at or before the token: EM4. 

An error message must be defined at level 1, 2, or 3. You must define 

it with an EM1, EM2, or EM3 statement. 

Error 16 

An invalid ALT number was found—it must be either 1, 2, or 3. 

Check for a missing or incorrect token at or before the token: ALT4. 

You can define no more than three alternatives in a rule, using the 
statements ALT1, ALT2, and ALT3. Change the incorrect ALT num- 

ber or delete the extra ALT statement(s). 

Error 17 

An invalid rule number was found—it must be between 1 and 255. 

Every rule in a rule type must have a unique rule number from 1 to 
255. If you have more than 255 rules for one rule type, define an addi- 
tional rule type and assign some of the rules to that type. 
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Error 18 

An invalid rule type number was found—it must be between 1 and 
100. 

Every rule type in a rule file must have a unique rule type number 
from 1 to 100. Change the incorrect rule type number. 

Error 19 

No first level error message was defined that has the same number 
of ALT strings as were specified in the preceding RULE statement. 

A rule’s level 1 error message must refer to the exact number of ALT 
strings you defined for the rule. For example, if you define two alter- 
natives for a rule (with ALT1 and ALT2 statements), the rule’s level 1 

error message (EM1) must refer to ALT1 and ALT2. Reword the mes- 
sage to refer to the proper number of alternatives. 

Error 20 

An ALT string with the same number has already been defined in 
this RULE statement. 

You can’t define the same alternative (ALT1, ALT2, or ALT3) more 

than once in the same rule. Change the incorrect ALT number or 
delete the extra ALT statement(s). 

Error 21 

An error message with this level number and same number of ALTs 
has already been defined in this RULETYPE statement. 

You can’t define the same error message with the same number of 
alternative references (ALT1, ALT2, and ALT3) more than once in the 

same rule type. For example, you can legally define the following two 
rules in a rule type: 

EM1 = “Don’t say ALT1.” 
EM1 = “Avoid using ALT1 or ALT2 except in direct quotes.” 



Writing Your Own Rules 

However, you can’t legally define the following two rules in a rule 
type: 

EM1 = “Don’t say ALT1 or ALT2.” 
EM] = “Avoid using ALT1 or ALT2 except in direct quotes.” 

Rewrite the EM statement(s) to eliminate the duplicate ALT numbers. 

Error 22 

An ALT number was defined more than once in the same error 

message. 

You have written an EM statement defining the same alternative 
(ALT1, ALT2, or ALT3) more than once in the same error message. 

Rewrite the EM statement to eliminate the duplicate ALT statement. 

Error 23 

If you use ALT2, you must also use ALT1. If you use ALT3, you 
must also use ALT2 (and ALT1). 

If you define or refer to more than one alternative, you must define or 
refer to a continuous sequence starting with ALT1. For example, you 
may define ALT1 and ALT2, but not ALT1 and ALT3. 

Note that you don’t have to define or refer to alternatives in order. For 
example, you may define ALT2 before ALT1. 

Error 24 

This rule number has already been used for this rule type. 

You have assigned the same rule number to two rules that belong to 
the same rule type. Change the rule number of one of the rules, or 
change its rule type. 
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Error 25 

Not applicable. 

Error 26 

This rule type number has already been assigned. 

You have assigned the same rule type number to two different rule 
types. Change the rule type number of one of the rule types. 

Error 27 

An error message with this level number has already been defined 
in this RULE statement. 

You have defined the same level of error message (EM1, EM2, or EM3) 

more than once for the same rule. Rewrite the rule to eliminate the 

duplicate EM statement. 

Error 28 

Rule type xxxxx was defined, but no rules were defined for this rule 
type. If you define a new rule type, you must also define rules for 
that rule type. | 

You have defined a rule type without defining at least one rule to 
belong to it. Remove the rule type definition that has no rules, or 
assign one or more rules to it. 

Error 29 

An unexpected end-of-file was encountered before the current state- 
ment was completed. Make sure the last statement is completed. 

MAKERULES encountered the end of the rule file at a point where a 
statement was incomplete. Correct or remove the statement that 
caused the error. 



Index 

* (any inflection of a word indicator), 101-102 

A 

abandon changes, 26 

abbreviations, adding to the user dictionary, 42 

Academic style guide, 53 

action commands, 21, 22-24, 32 

Action menu, 22 

Add command (Action menu), 22 

Advertising style guide, 53 

agreement errors, and CorrecText GCS, 78-79 

aliases, creating, 8-9 

alternative spelling suggestions, 23, 39 

ALTn keyword statement, 90, 93, 95-96, 97-98 

American English spellings, 48-49 

Analyze Readability Only command (Options 

menu), 36, 47-48 

and...and rule class, 58 

And/Or/But rule class, 58 

any inflection of a word indicator (*), 101-102 

Apple menu, adding Correct Grammar to, 9 

Archaic rule class, 60 

ASCII files 

using Correct Grammar with, 17-18 

for writing new rules, 90 | 

Automatic Spelling Suggestions command 

(Options menu), 39 

B 

backup copies of documents, 38 

Balloon Help, 14 

Basics style guide, 53 

Beginner rule class, 60 

blank lines in rule file, 98-99 

brightness for highlighting, selecting, 45 

British English spellings, 48-49 

Business style guide, 53 

Cc 

Cancel command button (Grammar Rules 

dialog box), 61 

Cancel command (Save Changes dialog box), 

26 

Capitalization rule class, 57 

categories of file format support, 16-18 

Check command (Action menu), 23 

checking documents directly. See direct 

method for checking documents 

checking documents on the Clipboard. See 

Clipboard method for checking 

documents 

checking documents for readability only, 47-48 _ 

Class Off command button (Grammar Rules 

dialog box), 61 

Class On command button (Grammar Rules 

dialog box), 61 

Cliche rule class, 59 

Clipboard method for checking documents 

beginning a grammar check, 30 

editing during a grammar check, 32-33 

interrupting a grammar check, 35 

moving text to the Clipboard, 29-30 

overview, 15-16 

pasting changed text, 33-34 
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Index 

Clipboard method (continued) 

saving changes, 33-34 

scrolling during a grammar check, 33 

using the Correction dialog box, 31 

Close command (File menu), 25 

closing 

a document, 25-26 

the tutorial window, 24 

Colloquial rule class, 59 

Color Wheel dialog box, 44-45 

comment lines in rules file, 98-99 

CompiledRules file 

creating with MAKERULES, 91-92 

saving, 4,5 

compiling rules file, 91-92 

Confused rule class, 60 

consecutive nouns readability setting, 66-67 

contractions, in rules, 102 

copying text to the Clipboard, 29-30 

Core Grammar rule classes, 60 

Correct command (Action menu), 23 

CorrecText Grammar Correction System 

(CGS), 77-80 

Correct Grammar Data file, 7 

Correct Grammar Data folder, 56 

Correct Grammar files, listed, 6-7 

Correct Grammar, how it works, 77-88 

Correct Grammar Preferences folder, 4-5 

Correct Grammar user dictionary. See user 

dictionary 

correcting and identifying errors, how Correct 

Grammar works, 80-84 

Correction dialog box 

action commands, listed, 22-24 

and the Clipboard method, 31 

and the direct method, 20-21 

curly quotes. See smart quotes 

Custom Dictionary, 40 

customization 

of grammar rule classes. See grammar 

rule classes 
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customization (continued) 

of readability rules. See readability rules, 

customizing 

of style guides. See style guides 

Custom style guide, 53 

D 

Default style guide, 53 

desktop publishing programs, and Correct 

Grammar, 6 

dialog boxes 

Color Wheel, 44-45 

Correction, 20-21, 31 

Grammar Rules, 54, 55, 61-65, 85 

Language, 49 

Readability Rules, 55-56, 65, 86 

Related Error Emphasis, 43-44 

Save Changes, 26 

dictionary. See user dictionary 

Dictionary Expert component of Correct 

Grammar, 81-82 

direct method for checking documents 

action commands, 22-24 

closing a document, 25-26 

displaying suggestions, 21-24 

editing during a grammar check, 25 

interrupting a grammar check, 27 

opening a document, 19-20 

overview, 15 

saving changes, 26 

scrolling during a grammar check, 25 

using the Correction dialog box, 20-21 

Discard command (Save Changes dialog box), 

26 

Display Readability Summary command 

(Options menu), 46 

documents typed in all capital letters, how 

Correct Grammar checks, 36 

dragging to an icon, to start Correct Grammar, 

9-10 



E 

editing during a grammar check 

Clipboard method, 32-33 

direct method, 25 

EMn keyword statement, 90, 93, 95-97 

Emphasize Related Errors command (Options 

menu), 43-45 

error messages 

creating 

escape sequences, 99-100 

overview, 90-91, 93 

using ALTn statements, 95-96, 97-98 

using EMn statements, 95-97 

displayed by MAKERULES compiler, 

117-124 

- 

Fiction style guide, 53 

file formats, categories of support, 16-18 

Flesch-Kincaid readability formula, 88 

Flesch Reading Ease Score, 86-88 

Flesch, Rudolph, readability expert, 86-88 

Fog index, 88 

folder 

for backup files, 38 

Correct Grammar, 4,5 

Correct Grammar Data, 7, 56 

Preferences, 4, 5, 40 

System, 4, 5 

for user dictionary, 40 

Format rule class, 58 

Fragments rule class, 58 

Francis, Dr. W. Nelson, computational 

linguist, 77 

G 

grade level readability setting, 69-70 

Index 

grammar problems and solutions, examples 

of, 71-75 

grammar rule classes 

creating, 90, 93-94 

customizing, 57-64 

displaying in Grammar Rules dialog box, 

54-55 

turning off/on, 60-61, 63-64 

See also specific names for rule classes 

grammar rules 

any inflection of a word indicator (*), 

101-102 

contractions, 102 

defining, 90, 93, 94-95 

limiting scope of, 106-107 

optional parts, 101 

spelling errors in matched text, 107-108 

trigger words, 100-101 

turning off, 24, 36, 60-63 

using logical expressions in, 104-105 

using macros in, 102-103 

using multiple operators in, 106 

writing new rules, overview, 90-91 

Grammar Rules dialog box, 54-55, 61-65 

Gunning, Robert, readability expert, 88 

Gunning Fog readability index, 88 

H 

hardware requirements, 2 

help, online, 13-14 

Help command (Action menu), 23 

highlighting for related errors, selecting, 43-45 

history of Correct Grammar program 

development, 77-80 

hue for highlighting, selecting, 44 

identifying and correcting errors, how Correct 

Grammar works, 80-84 
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Index 

Ignore command (Action menu), 23 

inflection of a word indicator (*), 101-102 

Informal rule class, 59 

Informal style guide, 53 

INIT conflicts, 36 

insert a correction, 23 

installation 

first time, 3 

on a network, 6 

upgrading from a previous version, 3-5 

International version of Correct Grammar, 38, 

48-49 

interrupting a grammar check 

Clipboard method, 35 

direct method, 27 

J 

Jargon rule class, 59 

K 

keywords, in rule files, 93 

Kucera, Dr. Henry, computational linguist, 77 

L 

Language command (Options menu, 

International version), 48-49 

Language dialog box, 49 

Launch CG file, 6, 8 

Learn CG file, 6, 11-12 

Legal style guide, 53 ) 

limiting the scope of a rule, 106-107 

linguistics research applied to Correct 

Grammar, 77-80 

logical expressions, using in rules, 104-105 

Look Up command (Action menu), 23, 39 
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macros, using in rules, 102-103 

macros recognized by MAKERULES, 109-116 

Make Backup Document command (Options 

menu), 26, 38 

MAKERULES application 

error messages issued, 117-124 

macros recognized, 109-116 

operators recognized, 108-109 

using to compile the UserRules file, 91-92 

MakeRules file, 7 

Master Lexicon, 81 

Misplaced ; rule class, 58 

Misused rule class, 60 

moving text to the Clipboard, 29-30 

MS Word 

file for using Correct Grammar with, 6 

user dictionary, 39-40 

MultiFinder, using with Correct Grammar, 20 

multiple operators in same rule, 106 

Mult. words rule class, 58 

N 

Next J command (Action menu), 23 

Nuances rule class, 60 

O 

online help, 13-14 

Open Clipboard command (File menu), 30 

Open Style Guide command (Rules menu), 56 

operators 

recognized by MAKERULES, 108-109 

using several operators in the same rule, 

106 

optional part of a rule, 101 

Options menu, overview, 37-38 



P 

Parse Analyzing Expert component of Correct 

Grammar, 83-84 

Parsing Expert component of Correct 

Grammar, 82 

Passive - main rule class, 59 

Passive - subord. rule class, 59 

passive voice, as readability factor, 85 

pasting changed text, 33-34 

pattern-matching systems, philosophy of, 79 

Permanent command button (Grammar Rules 

dialog box), 62 

Permanently command button (Quiet Rule 

dialog box), 63 

personal dictionary. See user dictionary 

Personal Dictionary command (Options 

menu), 39-40 

philosophy of Correct Grammar, 77-80 

predefined style guides. See style guides, 

predefined 

Preferences file, saving, 4 

prepositional phrases readability setting, 67-68 

Pretentious rule class, 59 

printing a readability summary, 47 

Proper Nouns rule class, 58 

Punctuation rule class, 57 

Q 

Question? rule class, 58 

Quiet command (Action menu), 24 

Quiet command button (Correction dialog 

box), 63 

R 

RAM Cache, 2 

Index 

readability 

checking for readability only, 47-48 

determining, 45, 86-88 

how Correct Grammar checks, 84-86 

maximum, exceeding the, 24 

summary, 45-48, 85-86 

Readability (only) style guide, 53 

readability rules, customizing, 64-70 

for consecutive nouns, 66-67 

for grade level, 69-70 

for prepositional phrases, 67-68 

for sentence length, 68-69 

for split infinitives, 66 

Readability Rules command button (Grammar 

Rules dialog box), 62 

Readability Rules dialog box, 24, 55-56, 65, 86 

Read Me First file, 3, 5, 7 

Redundant rule class, 59 

Related Error Emphasis dialog box, 43-44 

related errors, selecting highlighting for, 43-45 

Restore Rules in Class command button 

(Grammar Rules dialog box), 61 

Resume command (Action menu), 24 

resuming a grammar check, 23, 27-28 

Revert command (Edit menu), 25 

Reviewer style guide, 53 

Review Style Guide command (Rules menu), 

54, 55, 63-65 

rule classes. See grammar rule classes 

rule file 

comment lines, 98-99 

overview, 93 

RULE keyword statement, 90, 93, 94-95 

Rule Off command button (Grammar Rules 

dialog box), 61, 62-63 

rules, grammar. See grammar rules 

rule settings, in predefined style guides, 54-56 

Rules menu, 52-53 

rules, readability. See readability rules, 

customizing 
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Index 

RULETYPE keyword statement, 90, 93-94 

Run-on rule class, 58 

S 

Save As command (Save Changes dialog box), 

26 

Save Changes dialog box, 26 

Save command (Save Changes dialog box), 26 

saving changes 

Clipboard method, 33-34 

direct method, 26 

saving a readability summary, 46-47 

scope of rules, limiting, 106-107 

scrolling during a grammar check 

Clipboard method, 33 

direct method, 25 

Sentence Expert component of Correct 

Grammar, 80-81 

sentence length readability setting, 68-69 

Sentence rule classes, 58-59 

Share MS Word Dictionary command 

(Options menu), 39-40 

Skip 1x command (Action menu), 24 

skip current paragraph, 23 

skip current spelling problem, 24 

smart quotes, 25, 33 

spelling errors in matched text, 107-108 

Spelling and Format rule classes, 57-58 

Spelling rule class, 57 

spelling suggestions, displaying, 23, 39 

split infinitives readability setting, 66 

standard style guide, setting, 57 

starting Correct Grammar, 7-10 

Stats documents, 46-47 

style checkers, 79 

style guides 

customizing 

grammar rule classes, 57-64 

readability rules, 64-70 

grammar rules (turning off), 60-63 
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style guides (continued) 

predefined 

choosing, 56 

displaying list of, 52-53 

reviewing rule settings for, 54-56 

using as a standard, 57 

saving when upgrading, 4 

See also specific names of style guides 

suggestions 

and the Clipboard method, 31 

and the direct method, 21 

syntax errors displayed by MAKERULES 

compiler, 117-118 

system software requirements to run 

program, 2 

+ 

TeachText file, 7, 90 

Technical style guide, 53 

technical support, 14 

templates for writing rules, 90 

This Session command button (Grammar 

Rules dialog box), 62 

tips on working with Correct Grammar, 36 

Tour CG file, 6, 12-13 

trigger words in rules, 100-101 

spelling errors in, 107-108 

turning off rules, 24, 36, 61, 63-64 

turning on rules, 61, 64 

tutorial, 6, 11-13 

Tutorial command (Action menu), 24 

tutorial window, closing, 24 

U 

Undo Typing command (Edit menu), 25, 33 

upgrading from a previous version, 3-5 

Usage rules classes, 59-60 



user dictionary 

adding abbreviations to, 42 

adding words to, 22, 41-42 

changing words in, 40-41 

choosing, 10-11 

_ deleting words from, 40-41 

making larger, 42 

saving, 3-4,5 

selecting another, 39-40 

sharing with MS Word, 3, 5, 10 

UserRules file, 7, 90, 91 

Using CG with MS Word file, 6 

Using CG with Others file, 6 

Using CG with WordPerfect file, 6 

Index 

V 

Variants rule class, 58 

W 

Weak rule class, 60 

Well- rule class, 59 

Which/ that rule class, 60 

..Wise,...ize rule class, 59 

Word. See MS Word 

WordPerfect, file for using Correct Grammar 

with, 6 

word processor file formats 6, 16-18 

Wordy rule class, 59 

Write Readability Summary File command 

(Options menu), 46-47 
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WRITING TOOLS GROUP’S PLAIN LANGUAGE LICENSE 

You may use this software on any computer, as long as only one person uses it at a time. If several 

people use the software at the same time, you must pay one license fee for each additional person. 

If you use the software on a computer network, you must pay for as many licenses as the number 

of people who use the software. 

This software is protected by international copyright laws. You may copy it only for backup purposes. 

Writing Tools Group is licensing the software to you; it is not sold. 

Neither you or any reseller may rent, lease, sell licensed copies on approval, or otherwise transfer 

the right to use this software to another person, except that you may sell or give away your original copy, 

as long as you do not keep any copies. 

LIMITED WARRANTY 

ANY IMPLIED WARRANTIES INCLUDING ANY WARRANTIES OF MERCHANTABILITY OR FITNESS 

FOR A PARTICULAR PURPOSE ARE LIMITED TO THE TERMS OF THE EXPRESS WARRANTIES. 

WRITING TOOLS GROUP SHALL NOT IN ANY CASE BE LIABLE FOR SPECIAL, INCIDENTAL, 

CONSEQUENTIAL, INDIRECT OR OTHER SIMILAR DAMAGES ARISING FROM ANY BREACH OF 

THESE WARRANTIES EVEN IF WRITING TOOLS GROUP HAS BEEN ADVISED OF THE POSSIBILITY 

OF SUCH DAMAGES. Some states do not allow the exclusion or limitation of incidental or consequential 

damages, so the above limitation or exclusion may not apply to you. This Warranty gives you specific 

legal rights, and you may also have other rights which vary from state to state. Writing Tools Group's 

maximum liability shall not exceed the price paid by the enduser/licensee. 

Use, duplication, or disclosure by the Government is subject to restrictions as set forth in subparagraph 

(c)(1)(Il) of the Rights in Technical Data and Computer Software clause at DRARS 252.22 1-1013. 
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